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1. Using the Folder Browser 
The Folder Browser is one of the primary places for working with documents and folders 
in Laserfiche.  All documents in the repository are stored within the folder browser, and 
therefore it is important to be able to navigate the folder browser quickly. 
 

 

 
 
 

Figure 1: The Laserfiche Folder Browser 
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1.1. Designing a Folder Structure 
The folder tree is the first thing most users will see when they log in to a Laserfiche 
repository.  Because it is the primary interface with the repository, it is extremely 
important that it be well-organized.  It should be easy for users to decide where a 
document should be placed, and it should be intuitive to locate existing documents. 
 
The first thing to consider when designing a folder structure is who will be accessing 
those documents. The folder structure should be understandable and accessible for all 
users.  Consider not only the users who will be working with the system daily, but also 
the users who will work with it less frequently.  If you will be using WebLink to make 
the repository available to the general public, you should also keep those users in mind.  
The filing and naming structure should be as self-explanatory as possible. This will allow 
users to find the documents they need quickly. 
 
For example, a city council's repository will be primarily used by the city council 
members and staff, but will also be accessed by the public using WebLink.  Each 
document type – agenda, resolution, deed, ordinance, et cetera – is classified with a 
numerical code.  However, using these codes as folder names wouldn't be a good idea: 
although the council members and staff could readily identify them, members of the 
public would have trouble navigating them.  A member of the public looking for the city 
council agendas wouldn't necessarily know that 1047759-1 was the code for agendas.  If 
the folder was called "Agendas," however, even users who had never seen the repository 
before would be able to locate the correct documents. 
 
You can also use shortcuts to help make your folder structure more intuitive.  Shortcuts 
allow you to structure your repository such that it is usable in different ways.  For 
instance, you might have a set of folders that contain all the supplementary reports for 
agendas.  You want to store those reports in the same dated folders as the agendas, so that 
members of the public can quickly find them using WebLink.  However, you might also 
want the city clerk who must work with the reports to have quick access to them.  You 
might also want to be able to find the report in the folder corresponding to the report's 
subject – for instance, building plans in a Building Plans folder. Keeping separate copies 
in these folders would quickly become unmanageable.  Instead, you could place the 
report in one of the folders – for instance, the Building Plans folder – and then place 
shortcuts in the agenda folder and the city clerk's personal folder. 

1.2. Navigating the Folder Browser 
Like in Microsoft Windows, documents in Laserfiche are contained within folders, which 
may in turn be contained within other folders.  The structure of folders is called a folder 
tree.  As in Windows Explorer, the entire folder tree can be seen in a folder pane on the 
left side of the screen, while the contents of the folder you have selected – both 
documents and folders – is in the contents pane on the right side of the screen. 
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You can use keyboard shortcuts to quickly navigate and perform various actions in 
Laserfiche.  Many users find keyboard shortcuts to be significantly more efficient than 
using the mouse.  See Section 11. Appendix: Keyboard Shortcuts for an overview of 
useful shortcuts in Laserfiche. 

1.2.1. Navigating the Folder Pane 
You can move between folders simply by selecting 
them in the folder pane.  To see a folder's 
subfolders, you can either double-click the folder, 
or click once on the plus sign to the left of the 
folder icon.  You can also navigate between folders 
using the keyboard: use the ENTER key to expand 
a folder and see its subfolders, and the UP and 
DOWN keys to move between visible folders.  For 
more information on keyboard shortcuts, see Section 11. Appendix: Keyboard Shortcuts. 

1.2.2. Navigating the Contents Pane 
When you have selected a folder, the documents and folders within that folder are visible 
in the contents pane.  As in the folder pane, you can click on documents or folders to 
open them, or you can use the keyboard to navigate.  In addition to showing the name of 
the document or folder, the contents pane can display a number of other pieces of 
information, such as document type, number of pages, and volume.  You can reorder the 
columns by selecting one and dragging it left or right.  You can also sort documents 
based on the column information by clicking on the column.  For instance, clicking on 
the Type column will sort by document type.  By default, the column will be sorted in 
ascending order, but clicking it again will change it to sort in descending order.  

1.2.3. Tips for Creating an Easy-to-Use Folder Structure 
 
In order for a folder structure to be easy and intuitive to use, users should be able to 
locate relevant information after only a few quick decisions.  To facilitate that, here are 
some tips for creating your folder structure: 
 

• Self-explanatory folder and document names.  The name scheme for your 
folders and documents should be as understandable as possible. For instance, in 
the example above, you should use the word 'Agendas' for the folder rather than 
the agenda document code number, because the code is only comprehensible to a 
few people but the word is comprehensible to all users.  Similarly, it would be 
easy to find the city council meeting minutes for a particular year if the document 
name for minutes were of the format "Minutes – City of Utopia – 11/14/05." 
 

Figure 2: Expanding Folders in the 
Folder Pane. 

Figure 3: A Column in the Contents Pane 
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• Fewer choices at higher levels.  The more folders there are in the higher levels, 
the more difficult the user's first choice is.  If a user is confronted with fifteen 
folders as soon as they open the repository, they will need to scan over all of them 
and decide which is most relevant.  If there are only a few clearly-defined folders, 
they will be able to make the first choice much more quickly and accurately. 
 

• Folder ordering.  Laserfiche sorts documents and folders alphanumerically. You 
can use this sorting mechanism to order your folders in the way most useful to 
you. Thus, if you want to display folders in a particular order, you can preface the 
folder name with a number.  If you have three folders – Engineering, Accounting, 
and Human Resources – and you want them to display in that order, you could 
name them "1. Engineering," "2. Accounting," and "3. Human Resources."  
Similarly, if you have folders for every employee in your company, and you wish 
them to be sorted alphabetically by last name, you could name the folders after 
the employees, last name first. 
 

• Autonaming.  Using the autoname feature allows you to automatically give 
documents names that reflect aspects of their content.  For more information on 
autonaming, see Section 5.2.4. Autonaming. 

1.3. Managing Folders and Documents 

1.3.1.  Creating Folders and Documents 
Folders and documents can be created from within the Folder Browser.  To create a 
document or folder, you must first have the appropriate permissions: the entry access 
right Create Documents or Create Folder.  
 
To create a document or folder, first navigate to the folder in which you wish to create the 
new entry.  Then, select the File menu and choose New.  This will open a sub-menu.  
Choose Folder or Document.  You can also access the New sub-menu by right-clicking 
within the folder.  If you are creating a new document, the New Document dialog will 
appear; see Section 1.3.1.1. New Document Dialog for more information.  If you are 
creating a new folder, the folder will immediately be created; once it has been created, 
you can type a new name for it. 
 
Documents created in this way are 'empty' – in other words, they do not have any 
associated image pages or electronic document files.  Generally, you will instead create 
documents with pages, by scanning or importing documents into the repository.  See 
Section 5. Importing Documents and Section 8. Scanning for more information. 
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1.3.1.1. New Document Dialog 
When you create a new document, the New Document dialog will open.  This dialog 
allows you to customize the new document and add metadata to it. 
 
Name.  Type the name of the new 
document.  If you have configured 
Autoname options (see Section 5.2.4. 
Autonaming), your autoname will be 
supplied by default. 
 
General.  This tab allows you to specify 
which folder and volume to create the 
document in.  The folder you currently 
have open will be listed as the default, 
but you can type or browse to another 
folder.  If you type the name of a folder 
that does not currently exist, the folder 
can be created.  Finally, you can choose 
whether or not to index the new 
document. Documents with text must be 

indexed before you can locate them with 
a full-text search. (If the repository is 
configured to automatically index new documents, this option will be selected and greyed 
out.) 
 
Fields. In this tab, you can choose a template for the new document and input template 
field information. For more information, please see Section 3.1. Templates. 
 
Tags.  In this tab, you can apply security or informational tags to the new document.  For 
more information, please see Section 3.2. Tags. 

1.3.2. Creating Shortcuts 
A shortcut is a pointer to another document or folder in the repository.  Shortcuts allow 
you to store a document in one place in your repository, but allow users to access it from 
one or more other places.  For instance, you might store all of your loan applicants' 
documents in a Loan Applications folder, but place shortcuts in the personal folders for 
your loan officers, so they can quickly access the applications they are handling. 
 
To create a shortcut to a document or folder, right-click the document or folder and select 
Copy, or select Copy from the Edit menu.  Navigate to the folder in which you want to 
create the shortcut.  Then, either right-click and select Paste Shortcut, or select Paste 
Shortcut from the Edit menu. 

Figure 4: The New Document dialog. 
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1.3.3. Moving Folders and Documents 
While using a repository, you may need to move documents or folders from one folder to 
another.  You can simply select an item or items and then drag and drop them into the 
destination folder, just as you would in Windows Explorer.  You can also use the Cut and 
Paste commands in the Edit menu to 'cut' the document or folder from one location and 
'paste' it to another.  If you are moving a folder, all of the documents within that folder, 
and all subfolders and their contents, will be moved as well. 

1.4. Customzing the Folder Browser 
You can customize many of the display options for the folder browser from the Browser 
Options menu.  To open the Browser Options dialog, open the Tools menu and select 
Options, then click the Browser icon in the Options menu.  The Browser Options dialog 
allows you to configure the appearance of the Laserfiche Client's folder tree and folder 
browser. 
 
Column Display: You can configure the default columns that are displayed in the folder 
browser for folders and documents.  This allows you to display some or all of the 
template field values as well as more general information.  Under Column display 
should be…, select The same for all folders if you want a consistent column display, or 
Remembered for each folder if you want the ability to customize column display for 
each folder.  

 
Document icons: The Laserfiche 
document icon's color depends on 
the features of the document 
itself.  This setting allows you to 
determine whether you want all 
of the documents from the same 
volume to have the same color, or 
all of the documents with the 
same template to have the same 
color.  The Use document icons 
for electronic documents check 
box controls the icon display for 
electronic documents.  By 
default, electronic documents are 
displayed using the icon 
associated with their native file 
format – Microsoft Word 
documents display the Word 
icon, and so on. If you select the 

'Use document icons' option, however, electronic documents will be displayed with 
Laserfiche document icons. 
 

Figure 5: The Browser Options dialog. 
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Options: The Display latest version only option allows you to specify that only the most 
recent version of a document should be visible.  See Section 3.4. Versions for more 
information on versions.  Checking the Save pane layout box configures the Laserfiche 
Client to remember whether the Folder Browser or Search panes were open when the 
Client was last closed, and to open the Client to that pane.  If the box is cleared, the 
Client will always open to the folder browser. 
 
Font: The Laserfiche Client uses the same font for the folder browser display as the 
default Windows Explorer font.  By selecting 'Use custom font,' you can customize the 
font display to choose the text font, size and style you prefer.  Click Change to specify 
the text font, size and style. 

1.4.1. Managing Prompts 
In many cases, dialog boxes in the Laserfiche Client have a check box that 
can be selected to prevent the dialog from appearing in the future. The check 
box is usually called Don't ask me again or Do not show this dialog again.  
If this option is selected, the dialog will not be presented to the user again.  In 
most cases, the option selected at the time the Do not ask me again box is 

checked will be used as the default option in future cases. 
 
In addition, certain prompts can be turned on 
or off by selection Options from the Tools 
menu and then clicking the Prompts icon.  
These settings will apply to all repositories 
accessed by that particular Windows users on 
that computer; other Windows users and users 
on other computers will not be affected and 
can configure these prompts independently. 
  
For instance, a user who frequently moves 
items from one folder to another might wish to 
speed up the process by eliminating the Move 
/ copy / shortcut prompt.  He or she could 
either check Don't ask me again when next moving an item, or open the Prompts option 
dialog and uncheck Move / copy / shortcut. 
  
If you would like to turn on a prompt that had previously been turned off, there are two 
options.  If the prompt is one that is listed in the Prompts option dialog, you can select it; 
this will cause the prompt to appear in the future.  If it is not, you can click the Reset 
button in the Prompt Options dialog.  Note that this will turn all prompts back on; you 
will need to again disable any prompts you do not wish to see. 

Figure 6: The Prompt Options dialog. 
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1.4.2. Customizing the Toolbar 
You can add, remove or rearrange the buttons displayed in the toolbar of the 
Folder Browser.  To do so, select Options from the Tools menu, and click 
on the Toolbar icon.  This will open the Customize Toolbar dialog box.  In 
this dialog, you can select buttons you would like to add to the toolbar from 
the Available toolbar buttons option and click the Add button, or you can 

select buttons you would like to remove from the Current toolbar buttons option and 
click the Remove button. 
 
If you customize the toolbar from within the folder browser, you will customize the 
folder browser toolbar.  If you open the document viewer and then open the Customize 
Toolbar dialog box from within that document, you will customize the document viewer 
toolbar. 
  
You can also determine whether toolbar icons should be small or large, whether they 
should have text labels, and where on the screen the toolbar should be positioned. 
 

 
Figure 7: The Customize Toolbar dialog. 

 

1.4.2.1. Creating a Custom Toolbar Button 
To create a custom button, open the Customize Toolbar dialog and click the Custom 
button.  This will open the Toolbar Button Properties dialog. 
  
The Toolbar Button Properties dialog has three options: Name, Command and Icon.  In 
the Name option, type the name you would wish to associate with the new custom 
button.  In the Command option, type or browse to the path to the application you wish 
the button to open.  For instance, to create a button to open Internet Explorer, you would 
input the path to the iexplore.exe file, which launches Internet Explorer.  Finally, in the 
Icon  option select an icon for the application.  Many executable files have a number of 
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icons associated with them; you can select one of these files and then browse the 
available icons to choose one. 
  
Click Ok to close the Toolbar Button Properties dialog.  You will need to open a new 
Client instance for the toolbar button to be implemented.  You will then be able to re-
open the Toolbar dialog and add the new button to your toolbar.  Clicking the new 
button will launch the specified application. 
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2. Viewing and Working With Documents 
You can open documents from the Folder Browser by double-clicking on the document.    

2.1. Types of Documents 
Broadly speaking, there are two types of documents: documents which consist only of 
TIFF image pages and text (also called "Laserfiche documents"), and documents which 
contain a file of another format, such as a Word document or Excel spreadsheet (also 
called "electronic documents").  Both of these document types can have TIFF image 
pages, text pages and metadata.  Laserfiche documents will always be viewed in the 
Document Viewer; you can choose how you wish to view electronic documents. 
 
Laserfiche uses an image encoding format called TIFF (Tagged Image File Format), 
which is a non-proprietary file type that can be opened in most image viewing programs.  
You can associated additional information, called metadata, with your Laserfiche 
documents and electronic documents. 

2.2. The Document Viewer 
In the Document Viewer, users with appropriate rights can view and modify Laserfiche 
documents.  You can open up to four panes in the Document Viewer, and move and 
resize those panes to your liking.  The available panes are Image, Thumbnails, Text and 
Metadata; the panes will be discussed in more detail below. 

 
Figure 8: The Laserfiche Document Viewer 
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To open a pane in the Document Viewer, you can open the View menu and select Views.  
You can also use the Document Viewer's toolbar buttons to show or hide the various 
views. 
 

 
Figure 9: The Pane Selection Buttons.  

From left to right: Image, Text, 
Metadata and Thumbnails. 

 
To close an open pane, you can simply click the 'X' in the pane's 
upper right-hand corner.  To switch the positions of two panes, grab 
the title bar of one of the panes and drag it onto the other pane.  To 
resize a pane, grab the edge of the pane and drag it to the desired 
position.  You can also undock a pane by clicking the Undock button 
in the pane's upper right-hand corner.  This will open the pane as a 
new window. 

2.2.1. Image Pane 
You can view the TIFF images associated with a document in the Image pane.  The 
Image pane displays one page at a time, and shows both the image itself and any 
annotations – such as highlights or sticky notes – that users previously applied to the 
image.  (For more information on annotations, see Section 2.4. Annotations.) 

2.2.1.1. Zooming In and Out 
Users can take a closer look at sections of the image – or get a broader view of the whole 

image – using the Zoom tool.  Select the Zoom tool from the Document 
Viewer toolbar and click on the image to zoom in.  If your mouse has a 
scroll wheel, you can also scroll up to zoom in, or down to zoom out. 
 
You can also use the cursor to enclose a certain section of the text.  The 
image will zoom in such that the surrounded section fills the image pane. 

 
You can also configure the default zoom in the settings.  This is the size the image will 
start at when you first open the document.  To choose a different default zoom, select the 
Tools menu and choose Options.  Click View Documents.  In the Default image 
settings option, choose the zoom level from the "Zoom" dropdown list. 

2.2.1.2. Scrolling 
If you are viewing an image at a size such that the entire image is not visible on the 
screen at once, you can scroll up and down to view the whole image.  There are two ways 
to do this.  First, you can use the scrollbar on the right side of the image, just as you 
would in any other application.  Second, if you are using any cursor tool except Zoom, 
you can use a mouse scroll wheel to scroll up or down. 

Figure 10: The 
Undock Button. 

Figure 11: 
The Zoom 
Tool. 
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If you are using a scroll wheel, you can also configure the Document Viewer to 
automatically load the next page when you scroll past the bottom of the page.  See 
Section 2.3. Customizing the Document Viewer for more information. 

 
You can also use the Panning tool to move around the image.  Select the 
Panning tool from the Document Viewer toolbar.  You can then use this 
tool to click on the image and 'drag' it up or down to move your view 
horizontally or vertically.   

2.2.2. Text Pane 
The text pane contains text associated with the document.  Most of the time, this will be 
text that has been OCRed from the image pages or extracted from an electronic 
document. Annotations can be added directly to text, just as they can to the image.  (For 
more information on annotations, see Section 3 Annotations.) 

2.2.2.1. Generating Text 
There are two fundamental ways to generate text from a document.  If the document has 
image pages, you can perform Optical Character Recognition (OCR) to 'read' the text 
from the image.  If the document has an electronic document portion, you can extract text 
from the electronic document directly.  If there is already text associated with the 
document – if it has already been OCRed or had text extracted from it, for instance – 
generating text again will overwrite any existing text. 
 

There are several ways to start generating text from a 
document; however, they all use the same dialog, so 
you can use any of them with the same results.  You 
can select a document or documents in the Folder 
Browser and select OCR/Extract Text/Index from 
the Tools menu or by right-clicking the document or 
documents.  You can click the OCR button in the 
Folder Browser.  You can open the document and 
then select OCR/Extract Text/Index from the Tools 
menu in the document viewer.  You can use any of 
these methods to either OCR or extract text, and all 
methods will ultimately open the same dialog. 
 
In order to OCR or extract text from the document, 
the first box must be selected.  (There are extremely 
few situations in which you would want to uncheck 
the box, in fact; generally, you should make sure that 
it remains checked.)  You can determine whether you 

want to OCR all the pages in the document or only selected pages.  In many cases – 
particularly for scans of text documents – you will want to OCR all pages.  However, if 
you know that certain pages are image-only (for instance, a document's cover page, or a 
photo), you might want to exclude that page from the OCR. 

Figure 13: OCR/Extract Text/Index 
Dialog. 

Figure 12: 
The 
Panning 
tool. 
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The Make Text Searchable box controls whether the documents will be full-text 
indexed.  When you index a document, its text is added to the full-text search.  If a 
document with text is not indexed, its text can be viewed in the Document Viewer, but 
you cannot use full-text search to find keywords in the document.  Again, you will 
generally always want to keep this box checked, since full-text search is one of the main 
reasons that text is useful in a document.  (If this box is grayed out, it means that an 
administrator has configured indexing preferences for the entire repository that cannot be 
modified for a particular document.) 
 
If you click the Options button, you can further customize your OCR process.  In this 
dialog, you can select the language for which you want to optimize your OCR settings.  
Setting the OCR language to match the language of the document will increase OCR 
accuracy.  You can choose whether to decolumnize text, so that text that takes up two or 
more columns on an image (for instance, a page from a newspaper or magazine article) 
appears as a single column in the text document.  Finally, you can choose to temporarily 
enhance or 'clean up' the image prior to OCRing.  If you choose this option, click the 
Configure button to specify your image clean-up preferences.   
 
The Image Clean-Up Options dialog allows you to deskew, despeckle, or rotate the 
image, or remove lines from it.  These processes are only for the purposes of enhancing 
the OCR, and do not permanently affect the images.  Deskew straightens crooked images.  
Despeckle removes tiny spots and other 'noise' from the image.  Rotate reorients the 
image; you can choose to rotate images either automatically or by a set amount.  
Automatic rotation is best if images may be imported in any orientation, but it takes 
longer than rotating by a set amount as the page must be OCRed at each possible 
orientation to determine the correct orientation.  If all pages will be imported with the 
same incorrect orientation, you should use Rotate 'by this amount.'  Finally, line removal 
allows you to remove horizontal or vertical lines from the image that might affect the 
quality of the OCR. 
 
The More Info… button in the OCR/Extract Text/Index dialog allows you to view 
more information about text searching, OCR and text extraction.  It also allows you to 
view the types of electronic document that can have text extracted from them. 
 
Once you have generated text from a document, you can view that text in the Text pane 
of the Document Viewer. 

2.2.2.2. Editing Text 
By default, the text pane is greyed out so that the text cannot be 
accidentally changed.  However, you can turn on text editing, which 
will allow you to change the text directly. This can be useful for 
repairing errors in the OCR; for instance, if a client's name was 
misread by the OCR, but you nonetheless wanted it to be searchable, you could modify 
the text so that the name was correctly spelled.  To turn text editing on or off, you can 
either select Edit Text from the Tools menu, or click the Edit Text button. 

Figure 14: 
The Edit Text 
Button. 
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2.2.3. Metadata Pane 
The Metadata Pane displays additional information relevant to the document.  It contains 
four tabs: Fields, Tags, Links and Versions.  For more information on the different kinds 
of metadata, see Section 2.2.3. Metadata. 

2.2.4. Thumbnail Pane 
The Thumbnail view provides a larger-
scale view of your document.  You can 
see several pages at once, and can scan 
through your entire document quickly.  
The thumbnail view is useful for quickly 
locating and opening pages.  You can also 
use the thumbnail pane to modify 
individual pages in certain ways. 
 
To open a page from the Thumbnail view, 
simply double-click the thumbnail image.  
You can move a page to a different 
location in the document by dragging and 
dropping, just as you would move a 
document in Windows: select the image 
and drag it to its new location.  (In fact, 
you can drag a page to a different place in 
the same document or into a different 

document.  To do the latter, just open another Document Viewer and drag the page from 
one thumbnail pane to the other.) 
 
To rotate one or more pages from the document viewer 
 

1. Select the page or pages in the thumbnail view.  
 

2. Right-click the documents. 
 

3. Select Rotate image(s)…  
 

4. Choose the amount you wish to rotate the images. 
 
If you want to split one document into multiple documents, you can also do this from the 
thumbnail view.  This will remove the selected page or pages and create a new document 
containing those pages.  Both image and text pages, and any annotations on the pages, 
will be moved to the new document. 
 

1. Select the relevant page or pages. 
 

2. Either right-click the pages and select New Document, or press CTRL-D. 

Figure 15: The Thumbnail pane. 
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The New Document dialog will open and allow you to configure the new document.  For 
more information on this dialog, see Section 5.2.1. Configuring Default Behavior for 
New Documents 

2.3. Customizing the Document Viewer 
You can customize the appearance and behavior of the document viewer 
to match the way you want to work with documents.  To open the View 
Document Options dialog, open the Tools menu and select Options, then 
click the View Documents icon in the Options menu.  The View 
Document Options dialog allows you to customize the appearance of the 

Document Viewer in the Laserfiche Client and configure the method for opening certain 
special types of files. 
 
Document View Layout: There 
are two basic options for the 
layout of the document viewer: 
Standard, which allows you to 
configure up to four panes, and 
Classic, which allows you to 
configure up to two panes and 
which is reminiscent of the 
Document Viewer in Laserfiche 
6.  Standard allows for more 
flexibility and the ability to see 
more information at once, while 
Classic may be desirable for 
users who were very comfortable 
with the Laserfiche Client 6. 
 
Default image settings:  This 
option allows you to configure 
the default magnification used to 
display an image in the 
Document Viewer.  Select the Page scrolling check box to configure the Document 
Viewer to automatically load the next page when you scroll past the bottom of the page.   
Font used to display text:  By selecting 'Change Font,' you can customize the font 
display to choose the text font, size and style you prefer for the text associated with the 
document. 
 
Metadata tabs shown: This options allows you to determine which metadata types – 
template fields, document links, tag and document versions – you wish to see in the 
Metadata section of the Document Viewer.  For more information on metadata types, see 
Section 3. Metadata. 
  

Figure 16: The Document Viewer Options dialog. 
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Open With: The Open With option allows you to customize the way that certain special 
document types are opened.  You can determine whether electronic documents should be 
opened with their native application, or whether the template field and any associated text 
or Snapshot images should be opened by default instead.  You can also determine 
whether zero-page documents should open just the Metadata dialog or the entire 
Document Viewer. 

2.3.1. Customizing the Document Viewer Toolbar 
You can customize the toolbar for the document viewer just as you can customize the 
toolbar for the folder browser.  The process is exactly the same, except you must open the 
Toolbar options dialog from within the document viewer rather than from the main 
Client application.  For more information, see Section 1.4.2. Customizing the Toolbar. 

2.4. Annotations 
Annotations are a way to add additional information to a page of your document.  
Annotations allow you to work with a Laserfiche document as you would a paper 
document – for instance, adding sticky notes or highlighting sections of the document – 
without actually modifying the image.  The annotations are applied over the image pages, 
without changing the underlying page.  There are four types of annotations in Laserfiche: 
stamps, sticky notes, highlights and redactions. 
 
Note:  Since annotations are applied over the image pages, annotations cannot be applied 
to electronic document files. 

2.4.1. Stamps 
A stamp is a small image placed on a page of your document.  For instance, you might 
mark approved documents with a stamp that says "Approved," or stamp "Confidential" 
on confidential documents.  Laserfiche comes with four default stamps: Faxed, Received, 
Approved and Confidential.  You can also create custom stamps tailored to your needs. 
 
There are three types of stamps.  Public stamps are available to any user in the 
organization.  Personal stamps are available only to the user who created them.  Single 
use stamps remain in the list of stamps only until you use a different stamp; then they are 
removed. 
 
A stamp can be made from almost any monochrome bitmap image.  If the image you 
want to use is in another file format, or is a color bitmap, you will need to convert it to a 
monochrome bitmap.  For many document formats, you can do this by opening the image 
in Microsoft Paint, selecting Save As, and then choosing Monochrome Bitmap from the 
file type list. 
 
Once you have saved the image you want to use as a monochrome bitmap, you can use 
that image as a stamp.  Once you have applied a stamp, you can rotate the stamp or 
change its color by right-clicking the stamp and selecting Rotate or Change color. 
 



 

    
Laserfiche Training Manual 

- 23 - 

To add a stamp 
 

1. In the Laserfiche Client, open the document to which you want to apply the new 
stamp.  If you do not want to apply the stamp to any document at this point, open 
any document. 
 

2. From the Tools menu, select Add Annotation and then Stamp, or click the 
Stamp button on the toolbar.  This will open the Stamp Manager dialog. 

 

 
Figure 17: The Stamp Manager. 

 
3. Click the Add button. 

 
4. Navigate to the monochrome bitmap which you want to add as a stamp. 

 
5. In the Add to list option, select Public if you want the stamp to be available to all 

users, Private if you want to only use the stamp yourself, or Neither if you wish 
to create it as a single-use stamp. 
 

6. Click Open. 
 

To apply a stamp to a document 
 

1. In the Laserfiche Client, open the document to which you want to apply a stamp.   
 

2. Navigate to the page to which you wish to apply the stamp. 
 

3. From the Tools menu, select Add Annotation and then Stamp, or click the 
Stamp button on the toolbar.  This will open the Stamp Manager dialog. 
 

4. In the Select a stamp option, select the stamp you wish to apply. 
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5. If you wish to apply the stamp in a color other than black, select the color from 
the Select color list. 
 

6. Click the Apply Stamp button.  
 

7. Click on the part of the image to which you want to apply the stamp. 
 
To remove a stamp 
 

1. In the Laserfiche Client, open the document from which you want to remove a 
stamp. 
 

2. Navigate to the page from which you wish to remove the stamp. 
 

3. Right-click the stamp and select Delete. 

2.4.2. Sticky Notes 
Sticky notes are small text notes you can apply to 
pages of a document, just as you would attach a 
physical note to a paper document.  Unlike 
physical notes, however, the text in Laserfiche 
sticky notes can be searched.  Sticky notes are 
placed on a specific part of the page.  For 
instance, if you want to comment on a particular 
paragraph, you can place the sticky note next to 
that paragraph.  
 
If you type the URL to a websites (for instance, 
beginning with http://, ftp:// or www), the URL 
will automatically be changed into a clickable 
hyperlink.  This allows you to click directly on the 
link and have the web page or file open.  You can 
also customize the color of a sticky note by right-clicking the note and selecting Change 
color. 
 
Sticky notes are useful for adding additional information to a document.  For instance, 
you might create a sticky note to a comment to a picture identifying the person depicted, 
or you might add a note to supplement an account number with the company name and 
contact information for that account.  Since sticky notes are searchable, you can use them 
to flag documents or portions of documents for another user.  If you saw a document that 
you wanted to bring to the attention of your co-worker, Jack, you could add a sticky note 
saying something like "Jack, this might interest you."  Jack could then perform a sticky 
note search of his name and return all the documents that his co-workers had flagged as 
potentially interesting for him.  For more information on sticky note searches, see Section 
8. Searching. 
 

Figure 18: An open sticky note.  When 
closed, only the sticky note icon is visible 
on the page. 
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To apply a sticky note 
 

1. In the Laserfiche Client, open the document to which you want to add a sticky 
note.   
 

2. Navigate to the appropriate page. 
 

3. From the Tools menu, select Add Annotation and then Sticky Note, or click the 
Sticky Note button on the toolbar.  
 

4. Click on the image to place the sticky note.  The Sticky Note dialog will open. 
 

5. Type your note in the box. 
 

6. Click the red X in the upper right-hand corner of the sticky note to close it and 
save the text. 
 

To remove a sticky note 
 

1. In the Laserfiche Client, open the document from which you want to remove a 
sticky note. 
 

2. Navigate to the page from which you wish to remove the sticky note. 
 

3. Right-click the sticky note and select Delete. 
 

2.4.3. Highlights 
You can emphasize or set off certain sections of a 
document you are working with by applying a 
highlight to the image. A highlight is a colored 
overlay of the image; it does not obscure the image.  
You can customize the color of a highlight by right-
clicking the highlight and selecting Change color. 
 

Figure 19: An image with highlighting 
applied. 
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To highlight your image or text 
 

1. In the Laserfiche Client, open the document to which you want to add a highlight.   
 

2. Navigate to the appropriate page. 
 

3. From the Tools menu, select Add Annotation and then Highlight, or click the 
Highlight button on the toolbar.  
 

4. Click and drag on the image to draw a box around the section of the image you 
want to highlight, or select the text in the text pane that you want to highlight.  
(See Section 2.4.5. Linking Text and Image Annotations for information on 
highlighting both image and text.) 
 

To remove a highlight 
 

1. In the Laserfiche Client, open the document from which you want to remove a 
highlight.   
 

2. Navigate to the appropriate page. 
 

3. Select the highlight by clicking on it. 
 

4. Either right-click the highlight and select Delete, or press the DELETE key. 

2.4.4. Redactions 
You can redact a portion of an image or text.  Once an 
image is redacted, only users with the See Through 
Redactions right for that document can see the text.  Other 
users will see an opaque black box.  Redactions provide 

page-by-page, paragraph-by-
paragraph or even line-by-line 
security for a document.  For 

instance, you might choose to redact a client's social 
security number to protect that client's identity, and 
configure your security settings such that only users with a 

legitimate need for that information can see through the redactions.  
 
To redact your image or text 
 

1. In the Laserfiche Client, open the document to which you want to add a redaction.   
 

2. Navigate to the appropriate page. 
 

Figure 20: A redacted image 
viewed by a user with the See 
Through Redactions right. 

Figure 21: A redacted image 
viewed by a user without the 
See Through Redactions 
right. 
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3. From the Tools menu, select Add Annotation and then Redaction, or click the 
Redaction button on the toolbar.  
 

4. Click and drag on the image to draw a box around the section of the image you 
want to redact, or select the text in the text pane that you want to redact.  (See 
2.4.5. Linking Text and Image Annotations.) 

 
To remove a redaction 
 

1. In the Laserfiche Client, open the document from which you want to remove a 
highlight.   
 

2. Navigate to the appropriate page. 
 

3. Select the redaction by clicking on it. 
 

4. Either right-click the redaction and select Delete, or press the DELETE key. 

2.4.5. Linking Text and Image Annotations 
In many cases, when you are highlighting or redacting text in a Laserfiche document, you 
will want to apply the annotation both on the image and in the text part of the document.  
This ensures that the annotation is visible however one views the document; in the case 
of redaction, it ensures that the information is redacted everywhere it might be seen by 
people who don't have the rights to see it.  
 
Redacting the text part of the document is also the only way to ensure that the redacted 
segment will not be searchable in Laserfiche, and that it will not be searchable if the 
document is exported as a PDF. You might also want sections of text that are highlighted 
on the image to be highlighted in the text portion, and vice versa.  
 
By default, if you apply a redaction or highlight to the text portion of the document, 
Laserfiche automatically applies the annotation to the image as well. This is called a 
linked annotation, and it allows you to redact both text and images in one step.  Note that 
linked annotations only work if you apply the annotation to the text of the document.  
Applying the annotation to the image will redact or highlight only the image, not the text. 
 
If you do not want text annotations to be linked to the image, you can turn off this option.  
In the Document Viewer, open the Tools menu and select Link text annotations to clear 
the selection.  To turn annotation linking back on, simply select it again. 
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2.5. Electronic Documents 
Any document which contains a file other than a TIFF image or a text page is an 
electronic document.  For instance, if you imported a Word document or an Excel 
spreadsheet into Laserfiche, it would be an electronic document.  Electronic documents 
can be opened in their native applications directly from the Laserfiche repository.  For 
instance, you could open a Word document from Laserfiche, and Microsoft Word would 
launch and open the document. 
 
Electronic documents are represented by their native file format icons – for instance, an 
Adobe PDF file in Laserfiche will use the same icon that it would in Windows Explorer.  
This allows you to quickly determine at a glance what type of file you are opening. 

2.5.1. Opening Electronic Documents 
If you want to view the electronic document – for instance, if you have imported a 
spreadsheet to Laserfiche and you would like to view it or change it in Excel – you will 
want to open the Electronic File portion of the document.  This is the default method of 
opening an electronic document.  If you double-click on the document in the repository, it 
will launch in its native application.  (You can also right-click the document, choose 
Open and then choose Electronic file.) 
 
You can also open the document in the document viewer.  This will not open the 
electronic file itself.  Instead, it will allow you to view the document's metadata (any 
template fields, links, tags or versions associated with the electronic document), as well 
as any extracted text.  If you have printed images of the electronic file using Snapshot, 
those images will be included as well.  You can view the document in this manner by 
right-clicking it and choosing Open and then Pages. 
 

 
Figure 22: The Open command for an electronic document.  

You can choose to open the electronic file itself, or to open the 
pages and view the metadata and any images or extracted text. 

 
If you simply want to make the document's metadata visible, you can configure the folder 
browser view to display that information.  For more information, see 1.4. Customizing 
the Folder Browser 
 
You can change the default means of opening an electronic document so that the pages 
will open automatically rather than the electronic file. 
 
To change the default view for electronic documents 
 

1. In the Laserfiche Client, open the Tools menu. 
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2. Select Options. 
 

3. Select View Document. 
 

4. Under "Open electronic documents using" choose "The associated application" if 
you want electronic documents to launch in their native applications by default, or 
"Standard document display" if you want to view pages by default. 
 

5. Click Ok. 

2.5.2. Modifying Electronic Documents 
You can modify an electronic document simply by opening the electronic file and making 
the changes you want.  While you have that electronic document open, no other users will 
be able to modify it, although they will be able to modify its metadata or open it for 
viewing.  When you save and close the document, you will be prompted to save the 
document to the Laserfiche repository.  You will be able to save the document as a new 
version, save it as a new document, overwrite the existing document, or discard the 
changes you made.  (For more information on saving the document as a new version, see 
Section 3.4. Versions.) 
 

 
Figure 23: The Save dialog for electronic documents. 

 
The changes you made will only be saved to the repository if you save and close the 
document before you log out of Laserfiche.  If you want to be able to edit the document 
over a longer period of time, see Section 2.5.3 Electronic Document Check In and Check 
Out. 

2.5.3. Electronic Document Check In and Check Out 
If you are opening an electronic document in order to modify the file – for instance, if 
you want to make edits to a Word document stored in Laserfiche – you can check out that 
document.  Checking out an electronic document ensures that no other users attempt to 
modify that document while you have it checked out, even if you log out of the 
repository.  Checking out the document also saves a copy locally to your computer so that 
you can continue to modify it even when you do not have the Client open. 
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When one user has a document checked out, other users will be able to view the 
document, but not make any changes to it.  The copy of the document on the Server won't 
be modified until you choose to check the document back in, allowing you to discard 
changes if you decide you do not want to apply them. 
 
To check out an electronic document 
 

1. Right-click the document and select Check In/Check Out and then Check Out 
Document(s), or open the Action menu and select Check Out Document.  This 
will open the Check Out Document(s) dialog. 
 

2. The document will, by 
default, be stored locally in a 
"My Laserfiche Documents" 
folder in the "My 
Documents" folder.  You can 
choose another location, if 
you wish. 
 

3. Optionally, add a comment 
describing why you are 
checking out the document. 
 

4. If you wish to immediately open the document, check "Open document for editing 
immediately."  Otherwise, clear this box. 
 

5. Click OK to check out the document. 
 
When you have a document checked out, a pencil will appear on the 
icon for that document.  If another user has a document checked out, 
a red check will appear on the icon for that document.  To see who has a document 
checked out, and to read their Check Out comments, right-click the document, select 
Properties, and click the Check Out Details button. 
 

Note: Do not move or rename the file stored on your computer. If you move or 
rename the file, then Laserfiche will not be able to find it. If Laserfiche cannot 
find the file, then you cannot check in your changes. 

 
When a document is checked out, it cannot be modified by other users.  This extends to 
the document's metadata: other users will be unable to modify the document's template 
fields, add or remove tags from the document, change the version group of the document, 
or add other documents to the document's version group. (Other users can still create 
document links to or from the document, or delete other versions of the document.)  If the 
user who has checked out the document edits its fields or tags, however, the 
modifications to the metadata are cached locally and applied to the Laserfiche repository 

Figure 24: The Check Out Document(s) dialog. 
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only when the document is checked back in.  Changes to the links and version group are 
applied immediately, since they also affect other documents in the repository.   
 
When you are finished with a document, you can choose to undo the check out or to 
check the document in.  Both of these options are available by right-clicking the 
document and selecting Check In/Check Out.  Undoing the check out discards the 
changes you made, leaving the document in the repository unaltered; it also unlocks the 
document so that other users can check it out or modify it.  Checking the document in 
will apply the changes to the server. 
 
To check in a document 
 

1. In the Laserfiche Client, 
right-click the document 
and select Check In/Check 
Out and then Check In 
Document(s). 
 

2. Choose whether you want  
to save the document as a 
new version of the 
document, to save as a new 
document, or to overwrite 
the existing document. 
 

3. Click OK. 
 

4. If you choose to save as a new version, you can set new version comments.  A 
new document will be created and added as the most recent version of the original 
document's version group.  (See Section 3.4. Versions for more information.) 
 

5. If you choose to save as a new document, the New Document dialog will open.  
(See Section 1.3.1.1 New Document Options for more information.) 

 
To undo a check out  
 

1. In the Laserfiche Client, select the electronic document whose check out you wish 
to undo. 
 

2. In the Action menu, select Undo Check Out. 
 
Note: Administrators can also 'break' the lock on checked out documents.  For instance, if 
a user checked out a document and then went on vacation, and other users needed to be 
able to modify the document in the interim, an administrator could break the check out 
and allow other users to check out the document. 

Figure 25: The Check In dialog for documents that have 
been modified. 
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3. Document Metadata 
Laserfiche documents can contain additional information, besides that contained in the 
actual images, text and electronic files.  This information is called metadata.  For 
instance, in addition to storing a document itself, you might also want to keep track of 
when that document was added to your repository, to what user it is currently assigned, or 
whether it is a later version of an existing document.  There are four types of document 
metadata: templates, tags, document links, and versions. 
 
You can view a document's metadata by opening the metadata dialog directly, or by 
viewing the document in the Document Viewer.  To open the metadata dialog directly, 
select a document and open the Action menu.  Select the metadata type you want to 
view: View Fields, View Tags, View Document Links or View Versions.  You can also 
open the dialog by right-clicking the document and choosing View Fields.  Any of these 
commands will open the Metadata dialog.  

The Metadata dialog has four tabs – one for each metadata type – and the tab for the 
metadata type you selected will automatically be opened.  The Document Viewer's 
Metadata pane uses the same layout of four metadata tabs. 

Figure 26: The Metadata dialog, with the Fields tab open. 
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3.1. Templates 
Template design is essential to a well-thought-out file plan.  Because template data can 
be used to file documents and create folder structures, it is important to design templates 
with more than just document retrieval in mind. 

3.1.1. What are Templates? 
Templates allow Laserfiche users to attach a 
variety of metadata to documents. A 
template consists of a collection of template 
fields, each of which holds a specific item of 
information relating to a document—
customer names, filing dates, telephone 
numbers, unique ID codes, or anything else 
you choose to attach. Template information 
can include words, numbers, dates and times. 
Template information makes documents 
easier to find.  

3.1.2. Designing Templates 
In designing your templates, you will need to 
select properties for each field of the 
template. Depending on how you plan to use 
the templates, different template field 

properties can make a significant difference in data accuracy, speed of entry, and 
database size. The following sections will help you choose the appropriate field 
properties for your goals.  

3.1.2.1. Template Field Data Types 
The properties of a template field determine what information a user can enter in that 
field. The most important property of a template field is the type of data that it will 
contain. The following data types are available for Laserfiche template fields:  
 

• Character (Char). This type may contain a string of any type of characters. This 
is the most flexible type of field. Use this type when you are not sure if the 
constraints of the other types of fields will be appropriate. You can define your 
own constraints on char fields; see the next section for more information. 

• Integer. This type may contain a whole number between zero and 64,999.  

• Long integer. This type may contain a whole number between zero and 
3,999,999,999.  

• Date. This type may contain a date. Date fields will use the date format 
configured on your workstation, and will only accept valid dates (for instance, 
they will not accept a date of February 29 for a non-leap year.) 

Figure 27: The Template Fields tab of the 
Metadata dialog. 
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• Date/Time. Date/Time fields contain a date and time, which will be configured 
according to the settings on your workstation as with Date fields.  

• List fields. List fields allow you to create a list of values for users to choose from.  
List fields should be used whenever there are limited choices for field values.  
Using drop-down lists makes working with the template more efficient and 
ensures that the field values will always be consistent.  For example, a 
“department” field could list the departments in your organization. This allows 
your users to simply select a value rather than typing it in, and prevents differing 
values like Sales, Sales Dept., Sales Department, etc. that could make it difficult 
to search on that field.  

3.1.2.2. Other Template Field Properties 
In addition to the data types listed in the previous section, you may place several 
additional constraints on your template fields, as well as determining whether the fields 
are indexed for faster searching and whether they will contain a default value.  
 

• Name. To avoid confusion, your template field name should be as descriptive as 
possible. Note that if several templates share a field with the same name, you can 
display information from all of these templates in the same column in the folder 
browser.  

• Required. If the Required box is checked, a user will not be able to assign field 
data to a document or folder unless they fill in the required field. Be careful with 
required fields; using too many of them can significantly slow scanner operators, 
since any field that cannot be filled in will prevent the document from being filed 
and halt the scanning process until the information for that field can be located.  
(You can use default values to avoid this problem; if there is a default value for a 
field, that field will always be created with a starting value.) 

• Indexed. Checking the Index option will tell your DBMS to index the values in 
this field.  Fields do not need to be indexed in order to be searchable – all 
template fields are automatically searchable.  Indexing makes searches on that 
field faster and more efficient.  However, indexing is only useful if the values 
stored in this field are relatively unique (such as names or telephone numbers).  It 
provides little advantage for fields with only a few possible values (such as a 
Yes/No list field).  Indexing fields will increase your database size somewhat.  
Indexing all the fields in a template will negatively affect performance. Indexing 
should be used, therefore, in situations where one or two fields are searched much 
more often than the other fields, and those fields have relatively unique values.  
Note that indexing template fields is unrelated to indexing documents. 

• Width. This property applies only to character (char) fields. It determines the 
maximum number of characters that may be entered in the field.  

• Default value. Laserfiche provides the ability to set default values for any field 
on a template and recognizes “tokens” for special values that can be used to 
automatically fill in the field.  Default values can be especially useful for fields 
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that will always have the same value when they are first filed. For instance, 
applications and requests might be first filed with status "pending", which would 
be later changed to "approved" or "rejected." Setting "pending" as the default 
value for the Status field would save time for scanner operators.  
 
Similarly, information such as “scan date” or “document ID” can be automatically 
assigned to the documents using default values and Laserfiche “tokens.”  To 
automatically apply the current date to a “scan date” field, you can use the $date$ 
token as a default value.  See Section 10. Appendix: Tokens for more information.  

• Constraints. This property applies only to character (char) fields. If you wish to 
ensure that data is entered only in a specific format, you can set a constraint using 
regular expressions. For instance, to make sure that phone numbers are entered in 
the format 123-456-7890, you would create a field constraint with the value 
\d\d\d-\d\d\d-\d\d\d\d. These constraints are particularly useful for ensuring that 
data is entered correctly and completely, to ensure that it is easy to search for later 
on.  

3.1.2.3. Template Design Tips Summary 
The following is a quick summary of some of the tips given in this section. Note that 
many of the methods for increasing data accuracy will slow data entry.  
 
To improve data accuracy, completeness, and searchability:  

- use list fields wherever possible 
- use required fields 
- use constraints  

 
To increase speed of data entry:  

- create templates containing only necessary fields 
- don't use required fields and constraints unless necessary 
- use list fields 
- use default values and tokens 

 
To increase search speed, index one or two fields that are frequently searched. 
 
It is particularly helpful to combine these techniques.  For instance, if you frequently 
search by account number, you might want to make the account number field required, 
and set a constraint to ensure that the number will always be a valid account number.  
This increases the likelihood that the numbers will be correctly input, which in turn 
increases the likelihood that you will be able to locate the document using that number. 

3.1.3. Creating templates 
Any user with the "Manage Metadata" privilege can create templates in the Laserfiche 
Administration Console. Once a template has been created, users with this privilege may 
edit, reorganize or add to it using the same interface. Be aware that editing a template 
may affect existing metadata.   
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To create a template  

 
1. Open the Laserfiche Administration Console. Expand your repository item, 

expand the Metadata Management item, and select Templates. Select New 
Template from the Action menu or the context menu that appears when you 
right-click on Templates item.  
 

2. Choose a name for your template.  
 

3. Click the Insert button to create a new field. 
 

4. Under Field Name, type a name for the field. 
 

5. Under Type, select a field type.  See Section 3.1.2.1. Template Field Data Types 
for descriptions of the types. 
 

6. Under Width, type a maximum length in characters for the field. 
 

7. Under Default Value, type an optional default value.  You can use tokens for this 
value.  For a list of tokens, see Section 10. Appendix: Tokens. 
 

8. If you wish the field to be indexed, select the Indexed box.  
 

9. If you wish the field to be a required field, select the Required box. 
 

10. If you wish to use a field constraint, click the Constraint button to select or create 
a constraint.  Constraints use regular expressions – for instance, you could use the 
regular expression \d\d\d-\d\d\d-\d\d\d\d to ensure that phone numbers are input in 
the format XXX-XXX-XXXX, and contain only numbers and dashes.  You can 
also configure a constraint violation message, which will be displayed to users if 
they type an entry that does not meet the constraints.  For more information on 
using regular expressions, see the "Regular Expression Reference" in the 
"Metadata Administration" section of the Laserfiche Administration Guide. 
 

11. If the field is a list field, select the Edit List button to input the items that should 
be available in the list.  In the Edit List dialog, you can add or remove list entries, 
choose to sort them in ascending or descending order or leave them unsorted, or 
add a blank value to the list. 
 

12. Repeat steps 4-11 for each template field you wish to add to this template. 
 

13. When you have finished adding fields, you can re-order the fields by selecting a 
field and clicking the Up or Down button.  Templates in the Laserfiche Client 
will be displayed in the order configured here. 
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14. When you have finished, click OK to save changes to the template. 
 

 
Figure 28: The Template Creation dialog. 

 
Existing templates can be updated, reorganized or modified at a later time.  If a 
modification will affect existing data, the system will warn the user and ask if they are 
sure they want to make the modification. 

3.1.4. Filling Template Fields 
 

1. Open the Fields tab of the Metadata dialog for the document whose fields you 
wish to fill. 
 

2. Type a value in each template field you wish to fill, or select a value for list fields. 
 
Tip:  If you want to fill a Date or Date/Time field with the current date and time, 
press the spacebar. 

 
3. If you are viewing the metadata dialog on its own, click OK to save the values.  If 

you are viewing it in the Document Viewer, save the document to save the values. 
 
Required fields are marked in red.  You cannot save your changes if any of these fields 
are blank.  You will be unable to type a value that is not valid for the field type – for 
instance, if a field is of type 'integer,' and you try to type a string of non-numeric 
characters, the characters you are typing will not appear in the field. 
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Figure 29: A required template field. 

 
If you are filling a template field in the Document Viewer, you can open the text pane 
and drag text directly from that pane into the relevant template field.  As long as the text 
pane is not in Edit mode, the text will only be copied, not moved.  This is useful for 
quickly filling template fields with information from the document – for instance, an 
author's name or title.  

3.2. Tags 
Tags are an optional method for categorizing documents that can be added to or removed 
from a document at any point.  There are two types of tags: informational tags, and 
security tags.  Informational tags provide a purely informational categorization, while 
security tags can be used to restrict access to documents. 
 

 

3.2.1. Informational Tags 
You can mark and categorize documents using informational tags.  Informational tags 
simply flag a particular document; you can then either view the tags on a document or 
search for documents with that particular tag.  For instance, you might want to mark 
certain documents as having particularly high priority.  You could create an informational 
tag called "Priority" to mark documents that are of high importance, and then search on 
the Priority tag to locate and keep track of those documents. 

3.2.2. Security Tags 
Security tags are different than informational tags because they can be used to restrict 
access to documents.  Users can only open documents with security tags if the user has 
been assigned the security tag as well.  For instance, if the document "Report" has been 
assigned a security tag called TagA, the user JSmith will only be able to open that 
document if he or she has TagA as well. 
 
Security tags can be used to add another level of security – independent of folder 
structure – to documents.  For instance, your company's workflow process might route 
documents through several folders with different security settings.  For highly 
confidential documents, you might want to restrict access beyond that provided by your 
normal folder security.  You could use a security tag to implement this, since it wouldn't 
be dependent on the document's location in the folder tree. 
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3.2.3. Viewing Tags 
You can view the Tags tab by opening the Metadata dialog; see Section 3. Document 
Metadata.   
 
The Tag tab will display all the tags that can be applied to the document.  If the tag is 
currently applied, the box will be checked; if the box is not checked, the tag is not 
currently applied.  The tab will also display the description of the tag and any comments 
that might have been set. 

3.2.4. Creating and Applying Tags 
 
Tags are created in the Administration Console and applied to documents or folders in the 
Laserfiche Client.  Administrators can also apply security tags to users in the 
Administration Console; those users will then be able to open documents with that 
security tag.  It is a good idea to consider carefully what tags your repository needs, to 
ensure that you have the tags you need and to avoid extraneous tags.  Creating a tag will 
make it available for the entire repository. 
 
To create a tag for the repository 
 

1. Open the Laserfiche Administration Console. 
 

2. Select Metadata Management. 
 

3. Select Tags. 
 

4. Right-click and select New tag. 
 

5. Type the name of the tag in the Name field.  Optionally, type a description in the 
Description field. 
 

6. If the tag will be a security tag, check Security tag. 
 
To apply a tag to a document or folder 
 

1. Open the Tags tab of the Metadata dialog. 
 

2. Check the box for the tag or tags you wish to apply. 
 

 
Figure 30: The Tags tab of the Metadata dialog. 
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3. Optionally, select the Comments column and type a comment. 
 

4. Click OK. 

3.3. Links 
Document Links are ways of connecting two documents, regardless of where they might 
be in the repository.  If you have linked two documents, they will remain associated with 
one another regardless of where you move them in the repository, even if you rename 
them or otherwise modify them. 
 
For instance, you might use document links 
to associate an imported e-mail message 
with its attachment.  Thus, even if you 
moved the e-mail message and attachment to 
different parts of the repository, you could 
quickly find and open the attachment when 
viewing the e-mail and vice versa. 

3.3.1. Viewing Document Links 
You can view the Document Links tab by 
opening the Metadata dialog; see Document 
Metadata, above.   
 
The Links tab will display the document or 
documents which are linked to your current 
document.  You can view the name of the 
linked document, the type of link, and the 
document's location. You can also open the document directly by double-clicking on its 
name. 

3.3.2. Linking and Unlinking Documents 
You can link documents together directly from the Links tab.  You will use a document 
relationship to connect documents, and the link type you will use must be created before 
you link the documents.  Laserfiche 7.2 provides you with one default link type – 
"Supersedes" and "Superseded by" – but you can add more in the Laserfiche 
Administration Console.    It is a good idea to consider carefully what document 
relationships your repository needs, to ensure that you have the tags you need and to 
avoid extraneous document relationships.  Creating a document relationship will make it 
available for the entire repository. 
 

Figure 31: The Links tab of the Metadata dialog. 
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To add a new document relationship 
 

1. Open the Laserfiche Administration Console. 
 

2. Expand Metadata Management. 
 

3. Select Document Relationships. 
 

4. Right-click Document 
Relationships and choose New 
Document Relationship. 
 

5. Input the terms for the relationship.  
For instance, to link e-mails and 
attachments, you might use "E-
mail" and "Attachment."  To link 
an application and supporting 
documents, you might use 
"Application" and "Supporting 
Document." 
 

6. Click Ok. 
 
Once the document link type has been created, you can link documents using that link 
type.   
 
To link two documents using a document relationship 
 

1. Open the Document Links tab of the Metadata dialog. 
 

2. Click the "Create a document relationship" button, which has a green plus sign on 
it.  This will open a "Create a Document Link" dialog. 
 

3. Browse your repository and choose the document you wish to link. 
 

4. In the "Choose a link…" box, select the link type you would like to use. 
 

5. Click Ok. 
 
You can also remove document links from this same tab. 
 
To remove a document link 
 

1. Open the Document Links tab of the Metadata dialog. 
 

Figure 32: The New Relationship dialog. 
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2. Select the document which you would like to unlink from the current document. 
 

3. Click the "Remove the selected relationship(s)" button, which has a red X on it. 

3.4. Versions 
The ability to create new versions of a document was introduced in Laserfiche 7 and has 
been considerably expanded in Laserfiche 7.2.  Versions allow you to save modifications 
to a document as a different, but related, document. 

3.4.1. Why Use Versions? 
Different organizations use versions in different ways, depending on the way they 
manage and use documents.  Here are some examples of how and why document 
versioning could be used: 
 

• Tracking changes.  If you save modified documents as new versions of the 
original document, the older documents remain.  You can then compare older 
versions to newer ones to track changes.  Version tracking is enhanced by the 
ability to track the version creator and set comments on versions. 
 

• Preventing information loss.  When you create a new version of a document, 
you are not replacing any other versions of the document; instead, you are adding 
an additional version of the document to the version group.  Thus, the original 
document remains untouched.  If you want to review the previous version of the 
document, or return to the older version, you can still do so. 
 

• Maintaining different versions for different purposes.  You may wish to keep 
different versions of a particular document for use in different circumstances.  For 
instance, you might want to format a particular report differently to meet the 
requirements of different recipients.  You could use a version group to create and 
keep track of different versions of the report. 

3.4.2. Versions and Version Groups 
A version group is created when a new version of a document is created, either by 
importing or saving a document as a new version of an existing document, or by linking 
one existing document to another.  Both the original document and the newly created or 
linked document are considered versions of the same document within that version group.  
By default, documents do not belong to any version group; they are not added to a 
version group until they have either been linked into a version group, or have had another 
version created or linked from them. 
 
Laserfiche 7.2 allows you to track information about various versions.  In addition to the 
version's creation date, Laserfiche 7.2 keeps track of the user who created the version.   
You can also add comments to versions; see "Version Comments," below. 
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Each version is designated by a number; the latest version of the document is the 
document with the highest number.  (For documents that do not have a version group the 
version will be "None.")  When a new version is added to a document, it is added as the 
newest version of the entire version group.  In other words, Laserfiche version groups do 
not keep track of which specific document in the group the new document has been 
created from.  Regardless of the document you are working with when you save or link a 
new version, the new version will become the latest version for every document within 
the group. 
 

Example:  The document "Expense Report 2/24/06" does not have a version 
group: it is not a version of another document, nor are any other documents 
versions of it.  If you open the document's Versions tab, you will see that the 
Version column has a value of "None."  You open "Expense Report 2/24/06" and 
make some changes, then save it as a new version called "Expense Report 
2/26/06."  A version group will be automatically created; "Expense Report 
2/24/06" will now have a value of "1" in the Version column, and "Expense 
Report 2/26/06" will have a value of "2."  A few days later, you realize that 
another document – "John's Expense Report" – should also be in the same version 
group.  From the Versions tab of either of the other documents, you can click the 
Select an existing document to designate as the latest version button and 
designate "John's Expense Report," which becomes version 3.  Now, if you open 
the Versions tab of any of these three documents, you will see all three 
documents.  Thus, all three documents are part of the same version group, and 
"John's Expense Report" is the latest version of that group. 

3.4.2.1. The Versions Dialog 
The Versions dialog is available from the Metadata dialog.  You can open this dialog by 
selecting the document in the 
Laserfiche Folder Browser and 
selecting View Document Versions 
from the Action menu, or by 
selecting the Versions tab of the 
Metadata pane in the Document 
Viewer. 
 
The Versions dialog lists the files in 
the same version group as the 
currently selected document.  It also 
lists the version number, the date and 
time of creation, the username of the 
user who created the document, and 
the path to the document.  (If the 
document does not belong to a 
version group, only that document 
will be listed, and its version number Figure 33: The Versions tab of the Metadata dialog. 
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will be listed as "None.")  If you have the appropriate rights, you can open any of these 
documents directly from the dialog by double-clicking its entry in the list. 
 
You can also add or remove documents from the version group or view detailed version 
information from the Versions dialog.  This is done using the buttons at the bottom of the 
dialog. 
 

Select an existing document to designate as the latest version.  This allows 
you to chose an existing document in Laserfiche and add it to the current 
document's version group as the latest version.  See "Designating an Existing 

Document as the Latest Version," below, for more information. 
 
Import a new document to become the latest version.  This allows you to 
choose a document outside of Laserfiche, import it, and add it directly to the 

current document's version group as the latest version.  See "Importing a Document as the 
Latest Version," below, for more information. 
 

Remove selected document(s) as versions of this one.  This allows you to 
remove documents from the current version group.  Note that this does not delete 
the document.  The document removed from the version group will remain in the 

repository with no affiliated version group.  This means that, if you remove the document 
currently selected in the folder browser from the version group, the other documents will 
cease to be displayed in the Versions dialog; the document is no longer a member of their 
version group. 

 
View or modify the comment associated with the selected version.  This 
displays the information associated with the document you currently have 
selected in the Version dialog.  The Detailed Version Information dialog 

displays the document name, its location in the repository, its version number, creation 
date, modification date, and the user who created it.  It also displays, and allows you to 
modify, the comments on the version. 

3.4.2.2. Version Comments 
In Laserfiche 7.2, you can add comments to each version of a document.  Comments can 
be added when the document is created, or they can be added or edited using the View or 
modify the comment associated with the selected version button in the Version dialog.  
Since opening many versions of a document and scanning for variations would be 
cumbersome, you might use comments on versions to record the changes made to a 
version.  If users carefully comment when saving each new version of the document, 
however, locating changes is as simple as searching through the version comments or 
skimming the Comments dialogue for the versions.  

3.4.2.3. Version Display 
By default, the Laserfiche Client will display all versions of a document.  You can also 
configure it to show the most recent version only.  This is particularly useful if you are 



 

    
Laserfiche Training Manual 

- 45 - 

working with a document that has many versions but only need to work with the latest 
version.  Documents with no versions will always be displayed. 
 
To display only the latest versions of documents 
 

1. In the Laserfiche Client, open the Tools menu and select Options. 
 

2. Under Options, select Display latest versions only. 
 

3. Click Ok. 

3.4.2.4. Version Searches 
Laserfiche now provides a new Version search.  Using this search option, you can search 
for a particular word or phrase within version comments.  You can also specify that the 
search should only return the latest version of a document.  If a document is not part of a 
version group it will also be returned.  For instance, if you wanted to search for invoices, 
but only return the most recent versions of the invoices, you could perform a 
Document/Folder Name search for "Invoice," and add the Version search with the 
Limit search to latest versions box checked. You do not need to run a version 
comments search to use the Limit search to latest versions feature; this search 
constraint can be used with any other search type. 
 
You can also use the Created by search to locate all versions of a document created by a 
particular user. 

3.4.3. Creating New Versions 
A document can be designated as a version in three ways: by saving a newly-modified 
document as a new version, by importing a file from Windows as a new version, or by 
designating an existing document as a version of the document.  In either case, the 
document that you are creating or designating becomes the latest member of the original 
document's version group.  If the original document does not have a version group, a new 
version group will be created for it automatically. 

3.4.3.1. Saving an Electronic Document as a New Version 
You will be given the option to save an electronic document as a new version in two 
circumstances: when you are saving changes to an electronic document you have opened 
directly from Laserfiche, or when you are checking in a document that you checked out 
and modified.  Once you have saved or checked in the document, the procedure is the 
same. 
 
In order to save a new version of an electronic document, it must be present in your 
Laserfiche repository, and you must make a modification to it.  To save an electronic 
document that is not in your repository as a new version, see Section 3.4.3.3. Importing a 
Document as the Latest Version. 
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To save an electronic document as a new version 
 

1. Save or check in an electronic document.  The Laserfiche Electronic Document 
dialog will open. 
 

2. Select Save as a new version of the document. 
 

3. Click Ok.  This will open the New Document Version dialog. 
 

4. Under Comments, type any comments you wish to add to the version.  
Comments are optional.  If the document was checked out, the check in comments 
will be provided as a default version comment. 
 

5. Click Ok.  The new version will be saved according to your new document 
preferences. 

3.4.3.2. Designating an Existing Document as the Latest Version 
You can add a document that already exists in your Laserfiche repository to the selected 
document's version group.  The document you designate will become the latest version 
for that version group. 
 
To add an existing document to the version group 
 

1. Open the Versions dialog for a document in the version group to which you want 
to add an existing document. 
 

2. Click the Select an existing document to designate as the latest version button, 
represented by a green plus sign. 
 

3. Browse to the document you wish to add to the version group. 
 

4. Click Ok.  This will open the New Document Version dialog. 
 

5. Under Comments, type any comments you wish to add to the version.  
Comments are optional. 
 

6. Click Ok.  This will add the document to the version group. 
 
Note: The version group is determined by the document you have selected when you 
open the Versions dialog.  If the document you select in Step 3 already belongs to 
another version group, it will be removed from that group and added to the currently 
selected one. 

3.4.3.3. Importing a Document as the Latest Version 
You can import a document from Windows and add it directly to a particular version 
group.  The document you designate will become the latest version of the version group. 
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To import a document to a version group 
 

1. Open the Versions dialog for a document in the version group to which you want 
to add an existing document. 
 

2. Click the Import a new document to become the latest version button, 
represented by a folder and a green arrow. 
 

3. Browse to the document you wish to add to the version group. 
 

4. Click Ok.  This will open the New Document Version dialog. 
 

5. Under Comments, type any comments you wish to add to the version.  
Comments are optional. 
 

6. Click Ok.  The new version will be saved according to your new document 
preferences. 
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4. Searching 
Searching is one of the fastest and most effective ways of locating a document.  
Laserfiche was designed on the principle that you should be able to take any piece of 
information you know about a document and use that information to quickly locate the 
document.  To that end, you can perform a variety of different kinds of searches in 
Laserfiche, and combine those searches to pinpoint exactly the document you need. 

4.1. Wildcards 
Wildcards are a way of compensating for inconsistencies between your search term and 
the term in the document you wish to locate.  This is useful to compensate for OCR errors 
or typos, or to find different forms of a word – for instance, to find documents containing 
the terms 'swim,' 'swam,' and 'swimming.'   
 

• Asterisk (*).  The asterisk wildcard represents any number of missing characters, 
including zero.  For instance, a search on the term 'report*' would find report, 
reports, reporting, reported, reporter, et cetera. 
 

• Question mark (?). The question mark wildcard represents exactly one character.  
For instance, if you were unsure whether a name was spelled 'Anderson' or 
'Andersen,' you could search on the term 'Anders?n.'  This would return the results 
either way. 
 

• Brackets ([]).  Like a question mark, a set of brackets represents a single missing 
character.  However, brackets can be used to specify a smaller range of options.  
For instance, searching for 'd[io]ve' would find the words 'dive' and 'dove,' but not 
'Dave.'  Note: Oracle does not support brackets.  If your repository uses Oracle for 
its database management system, you can use brackets for full text searches but 
not for any other search type. 
 

• Dash (-).  The dash character is used in conjunction with brackets to specify that 
only characters within a particular range should be found.  For instance, you 
might want to locate all documents that contain an account number that begins 
with '100347' and ends with a number rather than a letter.  You could search on 
'100347[0-9].' This would return account number 1003475 but not 100347C. 

 
Wildcards can be used in combination.  For instance, if you wanted to return all 
documents with reference to writing or written materials, you could search on the term 
'wr[io]t*'  This could locate any of the following terms: write, written, writing, wrote. 
 



 

    
Laserfiche Training Manual 

- 49 - 

4.2. Basic Searches 

4.2.1. Basic Search Types 

4.2.1.1. Text 
The Text search performs a full-text search of the text portions of all documents within 

your repository.  You can use the Text search to 
locate documents containing specific key words.  
The search will return all documents which contain 
the specified word or words.  Text search is useful 
if you remember a particular phrase from the 
document you are looking for, or if the document 
or documents you are searching for have 
distinctive keywords.  If your repository is large, 

consider the words you are searching for carefully, or combine your text search with 
other searches, to keep the number of search results returned to a manageable size. 
 
You can use wildcards in conjunction with text search.  Text search is not case sensitive. 
 
Note: Full text search only works for documents which have text: Laserfiche documents 
which have been OCRed, and electronic documents which have had text extracted from 
them. 
 
There are some additional options for your text search. 
 
Phrase.  The default text search, phrase search, searches for multiple search terms as a 
phrase.  For instance, if you wanted to find documents containing the phrase "market 
exposure," you could type those words as a phrase search.  Documents would only be 
returned if they contained the exact phrase "market exposure."  If a document contains 
both the word "market" and the word "exposure," but they are in different parts of the 
document, the document will not be returned. 
 
AND.  The AND search allows you to find all documents that contain both of two words 
or phrases.  You could search for documents containing both the word "invoice" and the 
word "authorization."  All documents that contained both words – no matter where the 
words are in the document – will be returned; documents will not be returned if they 
contain only one of the words, or none of the words.  This is useful for narrowing the 
focus of your search, particularly if one of your search terms is common in documents in 
your repository. 
 
OR.  The OR search allows you to find all documents that contain one or both of two 
words or phrases.  If you wanted to find all documents that contained either the word 
"account" or the word "client," you could use an OR search.  Documents that contained 
either word, and documents that contained both words, would be returned. 
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NOT.  The NOT search allows you to find all documents that contain one word or phrase 
but do not contain another word or phrase.  This is useful for narrowing the focus of your 
search. 
 
WITHIN.  The WITHIN search finds all instances of two words or phrases within a 
certain number of words of each other.  You can input a second phrase, and determine the 
number of characters, sentences or paragraphs by which the two search terms can be 
separated.  (Sentences, in this context, consist of 10 words; paragraphs consist of 50 
words.)  This can help you find the specific document you are looking for, particularly if 
one of the search terms is very common and may match too many documents that are not 
the ones you are looking for. 
 
Fuzzy Search.  Fuzzy search can be used in conjunction with any of the above searches.  
Fuzzy searches locate both the exact matches to the search terms you provide and partial 
matches, where a certain number or percentage of letters in the result can differ from the 
search term.  Fuzzy searches are useful to account for any errors in OCR, uncertainty 
about the spelling of a word or name, words or names that may be misspelled in the 
document, or inflected versions of words (such as “swim” and “swam”). 
 
Under Criteria, determine whether you want the criteria for the fuzzy search to be the 
number of letters or the percentage of words in the search terms.  If you select Number of 
letters, you will need to input the maximum number of letters that can differ from your 
search terms and still return the result.  If you select Percentage of words, input the 
maximum percentage of letters in the search terms that can differ.  For instance, you 
might want to locate a document which refers to a particular person.  You don’t know 
whether the person's name is spelled "Sandra" or "Sondra," so you run a fuzzy search and 
specify that the number of letters can differ by one.  That way, regardless of whether you 
input "Sandra" or "Sondra," you will be able to find the document. You will not, 
however, be able to find documents that refer to the person by her nickname, "Sandy."  
To return "Sandy," you would need to increase the number of letters that can differ to 
two. 
 
Note: Fuzzy searches can take significantly longer than regular searches and may turn up 
less relevant search results.  Thus, it is usually best to try a regular search first and use the 
fuzzy search only if the regular search does not return the results you need. 

4.2.1.2. Document/Folder Name 
The Document/Folder Name search searches for 
the name of an entry.  You can specify whether 
you wish to search for documents or folders by 
selecting the "Document" or "Folder" boxes.  You 
can select both to locate both documents and 
folders.  (This search will also return shortcuts: document shortcuts are returned in 
document search, and folder shortcuts are returned in folder search.)  Document and 
folder name search is useful if you know the name or part of the name of the document 
you are looking for.   



 

    
Laserfiche Training Manual 

- 51 - 

 
If you know that a document is called "Application – John Doe," you can type that into 
the Document/Folder Name search to locate the document.  By default, the search will 
return only exact matches.  In other words, if you typed simply "John Doe," the document 
with the name "Application – John Doe" would not be returned.  You would need to use 
wildcards if you wanted your search to return that result. 
 
You can use wildcards in conjunction with Document/Folder Name search.  
Document/Folder Name search is not case sensitive. 

4.2.1.3. Field 
The Field search searches the template fields of 
documents in your repository. If you select a 
template from the list but do not type anything in 
the fields, the search will return all documents with 
that template.  If you select a template and type a 
word or phrase in one of the field, the search will 
return documents if they have the selected 
template and have a template field value matching 
that which you input.  If you type search terms in 
more than one field, the search will return 
documents only if their template field values 
match all of the values you input. 
 
Field searches are useful for targeting documents 

based on specific kinds of information that you or other users in your organization have 
configured, such as the patient on a healthcare form or the recipient of an imported e-
mail.  If you have set up your templates with fields that would be useful to you, and if 
you have kept your template fields updated (either manually or with tokens), template 
searches can very quickly locate and return exactly the documents that meet those 
specialized criteria. 
 
By default, the search will return only exact matches.  In other words, if you typed simply 
"Susan" in the From search above, the document whose From field contained "Susan 
Ieda" would not be returned.  You would need to use wildcards if you wanted your search 
to return that result. 
 
Date or Date/Time Field Searches.  If the template you are searching has a date field, 
you can search for documents whose date field contains a value that falls in a certain date 
range. If you want to return only documents with a date field value of one specific day, 
both ends of the range should be the same date; if the field is a date/time field, you should 
make sure that the time range spans the entire day.  If you leave one of the boxes empty, 
the search will be open-ended.  For instance, if you type a date in the From option but not 
the To option, you will retrieve all documents created after the date specified in From.  If 
you type a date in the To option but not the From option, you will retrieve all documents 
created after before the date specified in To. 
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You can use wildcards in conjunction with Field search.  Field search is not case 
sensitive. 

4.2.1.4. Within Folder 
The Within Folder search type is unique in that it  
cannot be used on its own; it must be combined 
with another search.  In effect, the Within Folder 
search is a constraint on other searches: it will 
return only documents that both fit the criteria of 
the other search and that are in the specified folder.  

Click the '…' button to browse to the folder.  If you select the Search subfolders box, the 
search will also return results from the selected folder's subfolders. 

4.2.1.5. Within Volume 
 
The Within Volume search type returns 
documents that are in the specified volume 
or volumes.  Select the volume or volumes 
you wish to search within from the list. 

4.2.1.6. Sticky Note 
This search type searches the text of all sticky 
notes in the repository and returns the 
documents whose sticky notes contain contents 
that match the search.  If you are displaying 
context lines for searches (see Section 4.5. 

Search Options), double-clicking on the context line for the search result will take you to 
the page that has the sticky note and open the sticky note.   
 
You can use wildcards in sticky note search.  Sticky note search is not case sensitive. 

4.2.1.7. Creation Date 
The Creation Date search type allows you 
to search for documents created during a 
specific period.  You can type dates in the 
From and To options, or you can click the 
calendar icon to browse to a particular date. 
If you leave one of the boxes empty, the 
search will be open-ended.  For instance, if 
you type a date in the From option but not the To option, you will retrieve all documents 
created after the date specified in From.  If you type a date in the To option but not the 
From option, you will retrieve all documents created before the date specified in To. 
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4.2.1.8. Modification Date 
The Modification Date search type is very 
much like the Creation Date search type, 
except it returns results that were modified 
during the specified period. 

4.2.1.9. Electronic Document 
The Electronic Document search allows you to 
specify whether you want to retrieve electronic 
documents or non-electronic Laserfiche 
documents.  If you select "Search for the 
following extensions," you can specify the 
electronic document types you wish to be 
returned.  (To select more than one document 
type, hold the CTRL key at the same time you 

click on the extensions.)  This allows you to search for particular types of electronic 
documents if you want to manage certain electronic documents in a particular way. 
 
Note: The list of extensions includes those extensions that exist or have existed in that 
particular repository, and so may vary from installation to installation, depending on what 
types of files have been present. 

4.2.1.10. Has Pages 
This search type allows you to specify whether 
you want to retrieve documents with no pages 
or documents with pages.  If you select Do not 
contain pages, you will retrieve electronic 
documents that have neither had images printed 
with Snapshot nor have had text extracted from 
them; you will also retrieve any empty 
documents that do not contain TIFF images or text.  If you select Contain image or text 
pages, you will return all documents that have TIFF image pages, all documents that 
have extracted or OCRed text, and all electronic documents that have had images printed 
with Snapshot.  If you select Contain OCRed text on, you can specify whether to return 
documents with text pages.  If you select no, only documents with no generated text will 
be returned.  If you select some, documents will be returned if they have generated text 
for some but not all pages.  If you select all, documents will be returned if they have text 
for all pages. 
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4.2.1.11. Relationship 
The Relationship search type allows you to 
find all documents to which a particular 
document link relationship has been applied.  
For instance, you might want to locate all 
documents that have been marked as having 
superseded another record.  You would choose 
the "Supersedes" document link from the list.  
You can also select multiple document link 

types – for instance, if you wanted to find all documents that were attachments to e-mail 
messages and that had been superseded, you could select both the "Attachment" and the 
"Superseded by" link types.  The Find documents with option allows you to determine 
whether you want to return documents with at least one of the selected links, or if you 
want to restrict your search to documents that have all the selected links. 

4.2.1.12. Tags 
The Tags search allows you to find all 
documents with a particular tag.  If you use an 
informational tag to specify which documents 
are urgent, for instance, you could use a Tag 
search to find all urgent documents.  If you 
use tag comments, you can also search for 
documents whose tag comments contain a 
certain word or phrase.  If you select more 
than one tag, the Find entries with option 
allows you to determine whether you want to 
return documents with at least one of the selected tags, or if you want to restrict your 
search to documents that have all the selected tags. 

4.2.1.13. Created By 
This search type allows you to find all documents and folders created by a particular user.  
It will also return shortcuts created by that user.  (Note that it is the user who created the 

shortcut that is relevant in this case, 
not the user who created the 
document or folder that the shortcut 
leads to.) You can use wildcards with 
this search type.  The search type is 
not case sensitive. 
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4.2.1.14. Version 
This search type allows you to search for a 
particular word or phrase within version 
comments.  You can also specify that the search 
should only return the latest version of a 
document.  If a document is not part of a 
version group and therefore has no versions, it 
will also be returned. Note that Limit search to 
latest versions cannot be used on its own; it must be used in conjunction with another 
search.  However, Limit search to latest versions doesn't need to be combined with 
Find documents with version comments containing – the two types of version searches 
can be used independently of one another. 

4.2.1.15. Checked Out Document 
You can locate the documents checked out by a 
particular user using the Checked Out 
Documents search.  This search will return all 
documents checked out by the specified user.   
 
 

4.3. Combining Searches 
You can combine multiple searches by simply selecting more than one search type in the 
Search pane.  Many search types lend themselves well to combined searches, and one 
search type – Within Folder – can only be used in conjunction with other searches. 
 
For instance, you might want to find the most recent version of all invoices created by the 
user AKIM.  You could do this by combining a Field search for documents with the 
template "Invoice," a Version search specifying Limit search to latest version, and a 
Created By search for the user AKIM.  This would return only searches that fulfill all 
three criteria, quickly pointing you to exactly the documents you want. 
 
Searches combined in this manner can only be combined as AND searches.  In other 
words, documents will only be returned if they meet all search criteria.  If you want to 
combine multiple searches more flexibly, see Section 4.4. Advanced Searching. 

4.4. Advanced Searching 
Advanced searching is a powerful way to locate documents and manage your Laserfiche 
repository. Using the advanced search syntax, you can combine searches in more flexible 
ways than you can with basic searches.  You can perform an Advanced Search by 
selecting Text search and then clicking the advanced text search tab.  
   
Users create advanced searches using the advanced search syntax.  Each search type has 
its own syntax – for instance, the syntax for a text search is simply the word you are 

Figure 34: The Version search. 

Figure 35: The Checked Out Documents 
search.



 

    
Laserfiche Training Manual 

- 56 - 

searching for; the syntax for a template field search is 
{[TemplateName]:[FieldName]="Value"}; the syntax for a tag is 
{LF:Tags="TagName"}.  A complete list of advanced search syntaxes is available in the 
Laserfiche Client help files.  You can refer to this list while you are using the Laserfiche 
Client by selecting Context from the Help menu and navigating to the section "Finding 
and Retrieving Documents." 
 
You can connect advanced search terms using & (which represents AND), | (which 
represents OR) or – (which represents NOT). If you wanted to find all reports that either 
had the template field Priority set to High or that had an Urgent tag, you would use the 
syntax {[Report]:[Priority]="High"} | {LF:Tags="Urgent"}.   You can create even more 
complicated searches by setting off part of the search string in parentheses.  For instance, 
a text search for invoice & (city | county) would return documents that contained either 
the word invoice and the word city or the word invoice and the word county. 
 
Wildcards can be used with most advanced searches. 
 

 

4.5. Search Options 
The Search Options dialog allows you to 
specify the fields that will be displayed in 
the search pane and to configure the 
appearance of searched-for text.  To open 
the Search Options dialog, open the Tools 
menu and select Options and then Search.   
 
Display object information:  You can 
configure which columns are displayed in 
the search pane.  This allows you to display 
some or all of the template field values as 
well as more general information.  When 
you perform a template search, the fields for 
that template will always be displayed in the 
Search pane. 
 

Figure 36: The Search Options dialog. 
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Highlight: This option allows you to customize the colors used to highlight keywords 
found in the search results.  This also allows you to set different colors to distinguish 
highlights on the image from highlights in the text. 
 
Search result display:  If you select the Show context lines option, the context of the 
text or sticky note search terms found in the document will be displayed when you select 
the search result in the search pane.  If you clear this option, no context will be displayed.   
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5. Importing Documents 
One method of adding documents to a Laserfiche repository is by importing electronic 
documents from Windows (for more information about electronic documents, see Section 
2.5. Electronic Documents).   Electronic document import is useful both for storing data 
that may change, such as Word documents that are in progress, and for storing files that 
are not text-based, such as photographs, audio, and videos.  Any of these types of files 
can have metadata such as template data and document links applied, making them easily 
searchable even if there is no “full text.”  Additionally, image files, such as JPGs and 
TIFFs, can be imported and either left in their native format or converted to Laserfiche 
documents. 

5.1. Import Methods 

5.1.1. Importing Images and Electronic Documents 
You can import single or multiple files from Windows into your Laserfiche repository 
through the Import Dialog.  TIFF files and image files on the image conversion list will 
be saved as Laserfiche documents; other file types will be imported as electronic 
documents.  
 
To import images and electronic documents 
 

1. From the Laserfiche Client, select File > Import…. 
 

2. The Import Files dialog will appear, displaying the Windows folder system.  
Browse to and select the file(s) you wish to import.  Click Import.   
 
Note:  If your options are set to 
skip the Import to Laserfiche 
dialog, Laserfiche will import at 
this time, and the following 
steps do not apply.  See Section 
5.2.1. Configuring Behavior for 
New Documents for more 
information. 
 

3. The Import to Laserfiche 
dialog will appear for the first 
(or only) file you have selected 
for import.   
 
In the General tab, name the 
document and type in or browse 
to the appropriate folder where 
you want the document stored 

Figure 37: The Import dialog. 
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in Laserfiche.  Select the correct Volume and choose whether or not you want to 
OCR or extract text (when possible). 
 

4. Click on the Fields tab if you want to enter metadata in the template.   
 

5. Click on the Tags tab to add tags. 
 

6. Click OK when finished. 
 

7. If you have selected multiple files for import, the next Import to Laserfiche 
dialog will now appear.  Repeat steps 3-8 for each file you are importing. 

5.1.2. Importing Briefcases 
Briefcases are collections of files exported from Laserfiche.  Briefcases retain the folder 
structure of the exported folders.  The metadata (field information, version information, 
etc.) will also be included.  Field data may be applied differently if the briefcase you are 
importing contains a template or templates that do not exist in your repository.  For 
example, you might import a briefcase containing a document with a template called 
Accounts Payable, but not have the same Accounts Payable template in your own 
repository.  In that case, Laserfiche will look for the closest match.  (If you have the 
Manage Metadata privilege, you can choose to create the Accounts Payable template if it 
does not already exist.) 
 
To import a briefcase 
 

1. From the File menu, select Briefcase. 
 

2. Select the briefcase you would like to import. 
 

3. The Import Briefcase dialog will open.  Select the folder and volume to which 
you would like to import the briefcase, and click OK. 
 

 
 
4. If the documents or folders in the briefcase have templates, the Template 

Selection dialog will open.  This dialog will display the templates found in the 
briefcase and the template in the repository which is the closest match.  If you do 
not want to match the template in the briefcase to the indicated template, you can 
click the Reassign Template button.  If you have the Manage Metadata 
privilege, you can choose to add it as a new template.  If there are more than one 
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possible matching template, you can select the template you want to use from the 
dropdown box.  Or you can choose to discard the field data for entries with the 
template.  Once you have finished template selection, click OK to complete 
briefcase import. 

5.1.3. Dragging and Dropping From Windows 
The simplest way to import documents into Laserfiche is to drag them from Windows 
and drop them into a folder in Laserfiche.  When you drag and drop files, they will be 
imported according to the default import settings you have configured.  If you import a 
nested folder structure from Windows, Laserfiche will automatically recreate it in 
Laserfiche and import the documents contained in all of the folders. 
 
To drag and drop from Windows 
 

1. Select file(s) or folder(s) in a Windows folder and drag the selection into the 
Laserfiche Client window.  
 

2. Drop the selection into the appropriate Laserfiche repository folder. 
 

3. The Import to Laserfiche dialog will appear unless your default behavior is 
configured otherwise (see “Configuring Behavior for New Documents” above).  
Proceed as outlined in the “Import Dialog” section. 

 

5.1.4. "Send To" from Windows and Office Applications 
 
Laserfiche is integrated with Microsoft Office and provides the ability to send documents 
directly from Office applications using the File > Send To > Laserfiche menu option.   
 

 
 
Office documents that are sent directly to Laserfiche can be indexed and filed in 
Laserfiche even if the Laserfiche Client is not open.   
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You can also import files of any type from Windows Explorer by right-clicking the file 
and selecting Send To > Laserfiche.   
 
To import using Send To 
 

1. Begin by either selecting File > Send To > Laserfiche in a MS Office application 
or by right-clicking a file in Windows and selecting Send To > Laserfiche. 
 

2. Either method of Send To will bring up the Laserfiche Repository Selection 
dialog box.  Select the repository into which the document(s) will be sent, choose 
your login preference, and click OK.   

 
3. The Import to Laserfiche dialog will appear unless your default behavior is 

configured otherwise (see “Configuring Behavior for New Documents” above).  
Proceed as outlined in the “Import Dialog” section. 

5.2. Configuring Document Import 
Imported documents will be handled as new documents.  For information on the options 
for new documents, see Section 5.2.1. Configuring Default Behavior for New 
Documents. 
 
The New Document options also allows you to customize certain behaviors specific to 
importing: the Outlook Import Options and the Import Conversion List. 

5.2.1. Configuring Default Behavior for New Documents  
Once you have imported a few documents, you will notice that there are numerous 
options displayed at each import.  It is likely that you will want similar settings applied to 
most of the documents that you import into your repository.  Laserfiche allows you to 
specify the default settings for imported documents, saving you the trouble of making the 
same choices every time you import.   
 
To configure your default settings 
 

1. In the Laserfiche Client, select Tools > Options 
from the task bar at the top of the screen.  
 

2. Double-click the New Documents icon. 
 

 
3. The New Document Options dialog will appear.   

 
 

4. Under Document template, select the template that you will use the most 
frequently. 
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5. Under Import to volume, choose the volume that you will use most 
frequently.  (There may be only one 
volume available.) 
 

6. Under Always show Document Metadata dialog, choose whether you 
would like the Import to Laserfiche dialog to open when you import 
documents.  Check the box if you will be entering metadata upon import 
or if you want to manually name and file documents; leave it blank if you 
will be importing large numbers of documents at once and entering the 
metadata later, or if you will be using default values to fill in the fields. 
 

7. Under OCR/Extract Text, check the box if you would like Laserfiche to 
generate fully searchable text on every document imported (when 
possible).  OCR, or Optical Character Recognition, is a method of 
'reading' the text from an image.  Text Extraction allows you to generate 
text directly from the text stream of an electronic document.  Leave this 
box blank if you would like to manually OCR/Extract Text at a later time 
or leave some documents without 
full text.  You can also choose 
whether or not to index the new 
document. Documents with text must 
be indexed before you can locate 
them with a full-text search. (If the 
repository is configured to 
automatically index new documents, 
this option will be selected and 
greyed out.)  See Section 2.2.2. Text 
Pane for more information about 
OCRing and extracting text. 
 

8. In the Save images as option, 
determine whether multiple images 
will be saved together as a single 
multi-page document or kept as 
separate documents.  For instance, if 
you were importing five images all 
belonging to the same document, you would select Multipage Document; 
if you were importing five images that were separate documents, you 
would select One page documents. 
 

9. Under New text page every ___ lines, you can set this dialog to break up 
text documents or OCRed or extracted text into pages.  
 

10. Configure your Outlook Options and File Options (see Section 5.2.2. 
Outlook Import Options and Section 5.2.3. Import Conversion List 
Options).  

Figure 38: The New Document Options 
dialog. 



 

    
Laserfiche Training Manual 

- 63 - 

11. Click OK.  You can also close the Options dialog if you have no other 
options to configure at this time. 

5.2.2. Outlook Import Options 
 
The Outlook Import Options dialog, 
which is accessed from the New Document 
Options dialog, allows you to tell 
Laserfiche what information it should 
extract from Outlook e-mails and where to 
put that information in the template.  By 
associating e-mail properties with template 
fields, you can automatically populate 
template data upon import of Outlook e-
mails. 

 
To configure Outlook options 
 

1. From the New Document Options 
dialog, click the Outlook 
Options… button.  The Outlook 
Import Options dialog will appear. 
 

2. The Attachments pull-down configures what will happen to any attachments on 
the Outlook e-mail.  You can keep the attachments as part of the e-mail (Leave in 
e-mail document), import them into Laserfiche as separate electronic documents 
(File separately), or both (Leave in and file a copy).  Choose the behavior that 
you would like Laserfiche to perform by default. 
 

3. Apply e-mail fields to attachments will be an available option if you choose to 
import attachments as separate documents (whether you are also keeping them as 
part of the e-mail or not).  Check this box if you would like the extracted metadata 
to apply to the attachments as well as the e-mail. 
 

4. Check File distribution list if you would like Laserfiche to add a page to the 
stored document that lists all recipients of the e-mail.  This page would include 
the display names and e-mail addresses of everyone listed in the To and CC 
properties of the e-mail.  If you are the sender of the e-mail, the BCC property 
will also be included. 
 

5. Next, you will configure the field associations for each appropriate template.  
From the Template pull-down, choose the template you wish to configure. 
 

Figure 39: The Outlook Import Options list. 
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6. For each appropriate field in the template, choose an e-mail property by clicking 
on <none> (or the current property listed) under the E-mail Property column, 
pulling down the menu, and choosing the correct property. 
 

7. Once you have chosen e-mail properties for all applicable fields in the template, 
you can configure another template if you wish.  To do so, simply pull down the 
Template menu to change templates, and repeat the process of setting field 
associations (step 6).   
 

8. To set one of the templates as the default for Outlook e-mails, choose that 
template in the Template pull-down and click the Default checkbox next to it.  
This is strongly recommended, as you can use it to ensure that all e-mails will be 
imported with a consistent template and with the appropriate fields filled with the 
correct default values. 
 

9. Once you have configured all desired templates, click OK.  
 

5.2.3. Import Conversion List Options 
 
The File Options dialog allows you to specify which image files should be automatically 
converted into Laserfiche files (images and/or text).  This setting is helpful if you have 
images that are scanned or otherwise received outside of Laserfiche Scanning, but you 
would like them to be stored in Laserfiche format so that you can work with them in the 
Document Viewer. 
 
To configure File Options 
 

1. Click the File Options… button from the 
New Document Options dialog (see 
above).  The Import Conversion List 
dialog will appear.  
 

2. If you wish to add a file type that is not 
listed, choose it from the Enter or choose 
a file extension drop-down or enter it as 
text in the field, and then click Add.   
 
Note:  Although many file types are 
listed, you should only choose image files 
or ANSI text files.  Other file types, 
including MS Word and other electronic 
documents, will be converted into 
“garbage” text.  To generate TIFF images 
that you can work with in Laserfiche from 
electronic documents, you must use Snapshot.  See Section 7. Snapshot for more 

Figure 40: The Import Conversion List 
dialog. 
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information. 
 

3. If you wish to store some image types in their native formats, remove them from 
the list by selecting the appropriate extension under Extensions which will be 
converted when imported into Laserfiche and clicking Remove.  
 

4. When finished, click OK. 

5.2.4. Autonaming 
The Autoname dialog allows you to configure the name that will be applied 
to Laserfiche documents by default if the user does not manually input a 
document name.  You can set your autonaming options by selection 
Options from the Tools menu and then clicking on the Autoname icon. 
 

Default Document Name: The default document name option allows you to specify the 
name that will be automatically assigned to documents if the user does not input a 
document name.  You can insert tokens into the default document name by selecting the 
token – Date, User name, et cetera – and clicking Insert.  See Section 10. Appendix: 
Tokens for more information. 
 
You can also determine which types of new documents should use this default document 
name.  For instance, you might want to use the name when creating a blank document or 
scanning a document, but not when importing a file. 
 
Count.  By default, if you use the Count token, the counter will start with one and 
increment every time it is used.  For instance, if your default document name is "New 
Document $count$," the first document you create will be called "New Document 1," the 
second will be "New Document 2," and so on.  To set the counter to start at a different 
number, input that number in the Current count token box. 
 

 
Figure 41: The Autoname Options dialog. 
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5.2.5. Best Practices for Importing 
Each of the outlined methods will work for importing any type of electronic document or 
image, so ultimately you should choose the method that seems easiest to you.  Here are a 
few tips for choosing an import method: 
 

• To import Microsoft Office documents that you have just created or modified, 
using the Send To method is often the quickest. 
 

• When importing large numbers of documents, it is often a good idea to configure 
your import settings to skip the Import to Laserfiche dialog; otherwise, this 
dialog will be presented for each document during the import. 
 

• The Import to Laserfiche dialog can be helpful when importing individual or 
small numbers of documents, as you can fill out the template information and 
assign any tags in one step.  This way, the document’s metadata is complete and 
ready for use upon import. 
 

• Make sure to consider what file types you want automatically converted to 
Laserfiche documents.  By default, many common image types (such as JPGs) are 
automatically converted in order to allow people to scan images in third-party 
applications and import them as Laserfiche documents.  However, you may want 
to store some images, such as photos, in their original format.  See the Import 
Conversion List section above for more information.  Note that many functions of 
the Laserfiche image viewer are only available for images that are stored as 
Laserfiche documents. 
 

• Keep in mind that Laserfiche documents can be exported in a variety of file 
formats when deciding whether to convert image files. 

 
Example:  Lisa has just finished an invoice in Microsoft Word, and wants to 
import the document into Laserfiche.  She does not have Laserfiche open, so she 
simply chooses File > Send To > Laserfiche in the Microsoft task bar.  She 
typically only imports a few documents at a time, so she has her import options 
configured to show the Import to Laserfiche dialog.  This allows her to fill out 
the template information without opening the Laserfiche Client.  She chooses to 
extract text from the document and completes the template, then sends the invoice 
to Laserfiche. 
 
Example:  Robert received a CD of files from a customer.  He wants to import 
the entire CD, about 50 files of different types, into a folder in Laserfiche.  The 
CD contains some images of the file type PNG, and Robert wants to make sure 
they will be converted so that the users can work with them in the Document 
Viewer, add annotations, and so on.  However, he does not want to go through the 
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Import to Laserfiche dialog for each file.  In the New Document Options 
dialog, he turns off the option Always Show Metadata Dialog.  Then, under File 
Options, he adds PNG to the list of files that will be converted to Laserfiche 
documents upon import.  After configuring these settings, he opens the CD in 
windows, selects all of the contents, and drags them into the appropriate folder in 
Laserfiche.  Laserfiche reconstructs the folder structure and file names without 
prompting Robert for any further information.  If he wants to add metadata, he 
can do so in Laserfiche once the import finishes or at a later time. 
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6. Exporting and Printing Documents 
Once you have documents in Laserfiche, you will want to not only browse or search for 
documents, but use the information that you find.  There are a variety of ways of getting 
information back out of Laserfiche so that you can use it for other purposes or share 
information with other people.  This chapter will cover exporting, copying and pasting 
portions of a document, and printing documents.   
 
Exporting a document typically means saving it in a form that someone else can use.  It 
often involves changing the file type or packaging the file differently so that people 
without Laserfiche, or other Laserfiche users who do not have access to your repository, 
can open it.  There are many options for export in Laserfiche, and when choosing how to 
export your documents, you should keep in mind your reasons for exporting, as they will 
frequently dictate your choices.  For example, when choosing what type of image file to 
use when exporting images, you would want to consider whether or not the exported file 
needs to be in color.  When e-mailing a document, you want to consider whether your 
recipient will be able to open that file type. 
 
There are five types of files that you can export from Laserfiche:  images, text, electronic 
documents, briefcases, and contents lists.  Each type includes different amounts of 
information. 
 
When you export images, you are simply exporting the TIFF images that are associated 
with the document—the scanned pictures of the pages.  You can export images to a 
variety of file types.  However, when you export images, you will not get document 
metadata and the text associated with the image, but only the image itself.  The only 
exception is when you export images as a PDF, the full text of the document will be 
searchable if the images are OCRed. 
 
When you export text, you are simply saving copies of the OCR or extracted text of a 
document in the form of text files.  The text file will contain no images or metadata. 
 
Likewise, electronic document exporting simply saves a copy of the electronic 
document in its native format.  Again, no images, associated text, or metadata is included. 
 
A briefcase is a Laserfiche document or set of documents that is packaged so you can 
move it from one Laserfiche repository to another.  The briefcase includes any images, 
text, electronic document information, or metadata that are associated with the document.  
However, a briefcase can only be opened in the Laserfiche Client. 
 
A contents list is simply a .csv (Comma Separated Values) file that lists the contents of a 
folder or a search result.  This file can be opened in Microsoft Excel or other spreadsheet 
programs.  The list will contain all of the items in the current folder or search results, 
along with all additional information that is currently being displayed in the Details view 
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of the contents pane, listed in the order in which it is displayed.  This function provides a 
handy inventory of a folder or search results list. 

6.1. Export Methods 

6.1.1. Text, Images and Electronic Documents 
There are a few ways to export text, images and electronic documents.  The methods may 
vary slightly for each type of file you are exporting, but they are all very similar. 
 
The first way to export is via the Export dialog.  To access this dialog, select the 
document you wish to export, and then choose File > Export from the task bar, or click 
the Export toolbar button.  (The Export toolbar button is not present on the toolbar by 
default, but it can be added; see Section 2.3.1. Customizing the Toolbar for more 
information.)  You will then have to choose the appropriate export type (Text, Images, 
Briefcase, Electronic document or List contents).  The options that are unavailable, 
such as Electronic document when you have selected an image, will be grayed-out. 
 
 The resulting export dialog will give you 
the options available for the type of file you 
have chosen to export.  Each will allow you 
to browse to the Windows folder where you 
wish your exported document(s) to reside 
and to name the file(s)—recall that if you 
are exporting a multiple-page document as 
single-page image or text files, the export 
will result in multiple files.  The Export 
Text dialog will also let you choose a page 
range and access the Text tab of the Export 
Options dialog, in case you want to change 
your defaults.  Though there is a Save as 
type field, the only option available for 
exporting text is a text file (*.txt). 
 
The Export Images dialog is similar to the text dialog, in that you can choose a page 
range and can access the Images tab of the Export Options dialog.  However, when 
exporting images, you also have the option of changing the file type.  The Save as type 
field will automatically be set to export according to the defaults that are configured in 
the Export Options; however, you can change the type as desired for each export by 
pulling down the menu and choosing another file type.  Note:  If you export images from 
a document that has been OCRed as a PDF, the PDF will be created with a text layer and 
will be fully searchable. 
 
When exporting an electronic document, the Export Electronic File dialog will appear.  
This dialog is very simple, allowing you to browse to the save location and name the file.  
As when exporting text, you are shown a Save as type field, but you cannot change it.  

Figure 42: The Export Text dialog. 
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The file will be exported in its native format.  The files will not contain metadata, 
annotations, etc. 
 
The export dialogs covered so far allow you to export single documents or multiple 
documents of the same type—for example, you could export images from a single 
document, or from many documents by selecting multiple documents that contain images 
and then choosing File > Export > Export images. 
 
However, you may wish to export entire folders that contain mixed file types—for 
example, a folder with both imaged documents and electronic documents.  There are two 
ways to export a folder or a folder structure in a format that can be viewed outside 
Laserfiche (for exporting folders that will be used in another Laserfiche repository, see 
the next section, Briefcases).  The first way, which requires the Laserfiche E-Mail Plug, 
is to drag a selected Laserfiche folder and drop it into a Windows folder or Desktop.  The 
second way is to right-click a folder and choose Export contents.  Either way, the 
Laserfiche folder will be recreated in Windows, complete with any subfolders, images, 
and electronic documents.  Metadata will not be included.  Laserfiche documents that 
contain images (whether or not they also contain text), will be exported as images only.  
All files will be exported using the default settings that you configured in the Export 
Options dialog. 

6.1.2. Briefcases 
As explained in the previous sections of this chapter, briefcases allow you to transport 
Laserfiche documents between repositories.  You can include any combination of 
documents or folders in a briefcase. 
 
To export a briefcase, first choose the documents that you wish to include in the 
Laserfiche Client.  You can do this by simply selecting a folder; by selecting one or more 
documents, folders, or shortcuts within a folder; or by making one or more selections in a 
search results window.   
 
From the task bar, choose File > Export > 
Briefcase.  The Export Briefcase dialog will 
appear. 
 
You will be able to name the briefcase and 
choose a destination.  You can also access the 
Export Options dialog by clicking the 
Options… button. 
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6.1.3. E-Mailing Documents 
 
Note:  E-mailing documents requires the Laserfiche E-Mail Plug-In. 
 
When it is necessary to export documents to give them to someone who does not have 
access to Laserfiche, emailing them directly from the system is often the simplest thing to 

do.  Documents can be emailed as images 
or PDF files and sent from your local 
email account.  Laserfiche can even warn 
you if your attachments exceed a specific 
size or Zip a group of attachments to save 
effort and bandwidth. 
 
The E-Mail Plug-In allows you to send 
attachments straight to Microsoft Outlook 
via two ways:  you can either simply drag 
the document(s) from the Laserfiche 
Client into your Microsoft Outlook 
window, or you can select the 
document(s) you wish to send and choose 
File > Email Document(s).  You will 
then be able to choose a file type for any 

imaged documents, as well as access the 
Export Options dialog by choosing 

Email Settings….  Outlook will then open a new e-mail message from your account with 
the chosen documents as attachments. 

6.2. Export Options 
 
Like many functions in Laserfiche, exporting requires you to make a few decisions that, 
if you have to make them repeatedly in your everyday tasks, could get tedious.  For that 
reason, you can configure the default behavior to match the choices you would make 
most of the time.  To do this, you would use the Export Options dialog, which you can 
access by choosing Tools > Options in the task bar, and then clicking on the Export 
icon. 
 
The dialog has four tabs.  The first tab is where you configure your options for exporting 
Images. 
 

Figure 43: The Export Briefcase dialog. 

Figure 44: The E-Mail Documents dialog. 
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The first box in the tab is Default image format, which allows you to choose what 
format will be selected by 
default when you export an 
image.  This default format can 
differ depending on whether 
you are exporting an image that 
is stored in color/grayscale, or 
in black-and-white.  To set 
these defaults, select the 
appropriate formats from the 
pull-downs, Color/grayscale 
image format and Black & 
white image format. 
 
One method of exporting, 
which will be covered later in 
the chapter, is by dragging 
documents from Laserfiche and 
dropping them into Windows.  
When you export by this 
method, all images will be 
exported in the same format.  Export dragged images in color determines whether this 
format will be color/grayscale (checked) or black-and-white (unchecked). 
 
Under Annotations and redactions, choose whether you want these items to be visible 
on the exported image.  For Include redactions on exported image, this controls 
whether the redactions will be present on images exported by a user with sufficient rights 
to see through redactions—if the user does not have access to redacted portions of the 
document, the exported image will have permanent redactions regardless of this setting. 
 
Under TIFF image options, check Export multiple images from the same document 
as a multi-page TIFF if you would like imaged documents to export in TIFF format as 
one file with multiple pages.  Single-page TIFFs have a separate file for each page. 
 
Under File naming convention, these options determine how files will be named if you 
choose to export them as single-page TIFFs, since a single Laserfiche document will be 
exported as many files, one for each page.   
 



 

    
Laserfiche Training Manual 

- 73 - 

The options for exporting text are fairly straightforward.  Under Text formatting, check 
Page breaks if you would like your text document to include page breaks.  Under 

Redactions, choose whether you 
would like to replace redacted 
text with a character, and if so, 
which character you would like to 
use.  For example, if you choose 
X, redacted text will be replaced 
with a series of Xs.  If you 
redacted the words "not to be" in 
the famous quote from Hamlet, 
the text would be exported as, 
“To be or XXXXXXXXX, that is 
the question.”  As with images, if 
the user who is exporting does 
not have access to redacted 
portions of the document, the 
exported text will be replaced 
with a series of Xs regardless of 
this setting. 
 
Under Multiple pages, these 

options are much like those in the Image tab.  If you choose to save a separate file for 
each page of text, you will have to set a naming convention for the pages, since each 
document can be many exported text files. 
 
Briefcases allow you to transport 
Laserfiche documents between 
repositories.  Briefcases are an 
export of a Laserfiche document 
or folder of documents.  You can 
include—or exclude—images, 
text, electronic documents, and 
annotations.  The metadata (field 
information, version information, 
etc.) will be included; however, 
field data may be applied 
differently in another repository 
if that repository does not have 
the same template that the 
original documents used.  For 
example, you might briefcase a 
document with a template called 
INVOICE.  If the repository to 
which you move the document 
does not have the same 
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INVOICE template, it will look for the closest match.  (If you have the Manage Metadata 
privilege, you can choose to create the INVOICE template if it does not already exist.) 
 
Under Redactions, choose whether or not to Make image redactions permanent.  Like 
the option in the Image tab, this option allows those with the appropriate privileges to see 
through redactions to make the redactions permanent in the exported briefcase. If it is 
unchecked, the redactions will still be in place when the briefcase is imported to another 
Laserfiche repository, and Laserfiche users with the See Through Redactions right in 
that repository will be able to see through them. Thus, you should choose to make image 
redactions permanent if they will be imported into a repository whose users should not be 
able to see the redacted information even if they have this right.  A user without the 
privileges to see through redactions on the documents included in a briefcase will export 
permanently-redacted images regardless of this setting. 
 
Under Range, choose whether you would like only documents in the current folder, or 
documents in the current folder and its subfolders.  Note:  Briefcases take up a lot of disk 
space.  It is often a good idea to create a folder and place shortcuts to the documents you 
wish to briefcase in that folder, rather than briefcasing an existing folder that has 
extraneous, unwanted documents in it. 
 
The Email options are very straightforward.  Simply choose whether you want a warning 

when attachments exceed a 
certain size—this setting is 
helpful when your e-mail server, 
or the recipient’s e-mail server, 
has a size limit for 
outgoing/incoming e-mail.  Then 
choose whether or not you would 
like to combine attachments into 
a Zip file.  Zip files allow your 
recipient to download 
attachments as a single file, 
which is nice when you need to 
send a lot of documents. 
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6.3. Copying and Pasting 
Sometimes exporting part of a document is more useful than the whole thing.  With 
Laserfiche you can copy a portion of a document and past it into another application such 
as an email or Word document.  If the document has been OCRed, you have the choice of 
pasting the image or text from the document. 
 
To copy and paste portions of the image and/or text 
 

1. In the Laserfiche Viewer, click and drag your cursor over a portion of an image to 
select it, and either select Edit > Copy from the task bar, or type Ctrl-C.  
Laserfiche will copy both the image and the text associated with the image, if the 
document has been OCRed.   
 

2. Paste the selection into the program of your choice.  Depending on the type of 
application, either the text or image will be pasted.  If you are pasting into a 
program, that can display either text or images, such as MS Word, use the Paste 
Special command (or equivalent). 

6.4. Printing 
Printing from Laserfiche includes the usual options, such as page range, number of 
copies, etc, as well as a few special ones.  One unique feature is the Print Type option, 
which allows you to choose to print Images, Text, Images and text, or Zoomed area of 
image.  The last option allows you to print only the area that is showing in the Laserfiche 
Viewer, and is useful for printing detail on large or intricate images.  The Auto-detect 
page orientation option will automatically determine whether the image should be 
printed with a  Portrait or Landscape orientation. 
 

 
Figure 45: The Print dialog. 
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Also, the Options… button will bring up a Print Options 
dialog, which allows you to choose whether you want 
applicable annotations and redactions to be printed.  You 
can also choose whether to print the image in its actual 
size, or scale it to fit the page on which you are printing 
(Scale to fit). 
 

Figure 46: The Print Options 
dialog. 
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7. Snapshot 
Laserfiche Snapshot is a program that allows you to print TIFF images of documents.  
Snapshot works in two ways.  First, you can use Snapshot on electronic documents that 
are already in the Laserfiche Client.  This adds a TIFF image to the electronic document, 
and generates searchable text for the document.  Second, you can use Snapshot outside 
Laserfiche in any program that allows you to print.  This will create a TIFF image and 
send it to Laserfiche as a Laserfiche document. 

7.1. When to Use Snapshot 
Snapshot can be used in several different ways for several different purposes.   
 

• Creating archived images.  Snapshot creates a TIFF image of a document and 
stores it in Laserfiche.  Although the original document might be altered, the TIFF 
image will not be altered unless you delete or overwrite it.  This is important if 
you need unalterable archived copies of documents whose original format is 
alterable. 
 

• Making electronic documents readable for users who do not have the native 
application.  For instance, you may have a CAD or other drafting document that 
you would like to make available to everyone in your organization.  However, 
you know that some users don't have a CAD program installed.  Since electronic 
documents open in their native formats, these users won't be able to view the 
documents.  If you Snapshot those documents, however, the TIFF images can be 
opened and viewed like any other Laserfiche documents, even by users who don't 
have the CAD program.  If you use WebLink or Web Access, you might want 
users to be able to look at the document immediately upon opening it in that 
program.  Without TIFF images associated with the electronic documents, you 
would need to download the electronic document to view it with these products.  
However, if you have printed TIFF images with Snapshot, those pages will be 
immediately viewable. 
 

• Extracting text from documents that cannot otherwise have text extracted.  
Although many document formats can have text extracted from them with 
Laserfiche 7.2, some document formats still cannot have text extracted from them. 
If you wish to generate searchable text from those documents, you will need to 
print them with Snapshot and generate text from the images. 
 

• Preserving the formatting of extracted text.  Although text generated by text 
extraction is very accurate, its format may not be easy to read.  For some 
document formats, extracted text creates a single long document with no 
formatting or line breaks.  If you want text that is easily eye-readable, you may 
want to use Snapshot in those circumstances. 
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7.2. Snapshot Configuration 
Once Snapshot has been installed, you should configure it to match the way you want to 
use it.  This will save you time in the future, since setting defaults for the way that 
Snapshot documents are handled means that you won't have to configure it by hand each 
time you print a document using Snapshot. 
 
When you open the Laserfiche Snapshot Configuration, you will be prompted to select a 
repository and log in to it.  This is the repository which Snapshot will print to by default.  
Once you have logged in, you will be presented with the Laserfiche Snapshot 
Configuration dialog. 

7.2.1. General 
The General tab of the Laserfiche Snapshot Configuration dialog allows you to set some 
basic properties and methods for handling documents. 
 
Document properties.  This option 
determines whether the document 
properties dialog will be opened once a 
document has been printed.  If you 
choose not to view the dialog after the 
document has been printed, the default 
settings will be applied to that 
document.  If you will be printing 
many documents and do not want to 
stop and assign properties to each of 
them individually, or if you do not 
need to customize the properties 
beyond the default settings, you should 
select Assign it default properties.  If 
you do need to modify the properties 
for individual documents printed to 
Laserfiche, you should select 
Show\modify document properties. 
 
Settings.  This option allows you to 
change the settings for the Snapshot 
printer itself.  These settings include paper size and orientation, file formats, 
watermarking and annotation, and numbering.  To modify these settings, click the 
Settings button.  For more information on these settings, see Section 7.3. Snapshot 
Printer Properties. 
 
Laserfiche repository.  Here you can change your repository and the Laserfiche user you 
are logged in as.  By default, this will be the same as the repository and user name you 
entered when you first opened the configuration dialog.  Clicking the Change button will 
open that same dialog to allow you to change your repository and user name. 
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Count.  This option allows you to set the starting number for the Count token.  For 
instance, if you wanted to consecutively number documents starting with the number 1, 
you would select 1 in the Set Count to option, and then configure the document name to 
use the Count token.  (See Section 7.2.2.. Destination, and Section 10. Appendix: Tokens 
for more information.)  Count can be configured to use leading zeroes; for instance, if 
you would like all numbers to be generated with four digits (for instance, the first 
document would be 0001, the second 0002, et cetera), you would simply set the Count 
token to 0001.  The number will be correctly incremented and printed with leading 
zeroes. 

7.2.2. Destination 
The Destination tab allows you to configure what the newly-created document will be 
named, where in your repository it will be placed, and what volume it will be stored in. 

 
Document name.  You can type a 
document name in this option that will 
be applied to any printed documents.  
Document names can contain text (such 
as 'New Document' or 'Printed 
Document'), tokens, or a combination of 
the two.  For instance, you might want 
each document to be named "Report" 
followed by the date and time that the 
document was printed to Laserfiche.  
You could type "Report - $DateTime$" 
into the Document name option. When 
the document is printed, the DateTime 
token will be replaced by the actual date 
and time of printing.   
 
Folder.  This option allows you to 
specify the repository folder in which 
you want to store the printed documents.  
Click the … button to browse to a 
folder, or use the > button to insert a 

token.  If you specify a folder that doesn't exist, Snapshot will create it. For instance, you 
could specify the path RepositoryName/Accounting/$User$.  This would place the 
printed documents in a folder with the same name as the user who printed it, which in 
turn is inside the Accounting folder. 
 
Volume. You can select the volume into which you want to store the image in this 
option.  Simply select the volume from the list. 

7.2.3. Template 
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The Template tab allows you to both 
set a default template and configure 
default values for that template's fields. 
 
Template: This option allows you to 
select the template that will be applied 
to printed documents.  Select a 
template from the list, or choose <NO 
TEMPLATE> if you do not want to 
automatically assign a template. 
 
Field population.  If you have 
selected a template in the Template 
option, you can set default values for 
that template's fields.  As with 
document names, template field values 
can be set to static text, dynamic 
tokens, or a combination.  You might, 
for instance, have an "Imported By" 
field, and set the value to $User$. 

7.2.4. Tags 
In the Tags tab, you can specify which tags (informational or security) will be applied to 

a document.  Check the boxes for the 
tags you wish to apply by default to 
printed documents.  As with other 
security, the tags available are 
determined by the user logged into the 
Laserfiche Snapshot Configuration 
utility. 
 
 
 

7.2.5. Document Handling 
In the Document Handling tab, you can specify what you want to happen if a document 
of the same name already exists in the same folder.  Create a new document creates the 
printed document as a new document with (1) appended to the name.  If a document of 
the same name with (1) appended already exists, the document will be created with a (2) 
appended, and so forth.  Append pages to the existing document will add all of the 
printed pages to the end of the document.  Prepend pages to the existing document will 
add them to the beginning of the document.  Replace all pages in the existing document 
overwrites the existing pages with the printed pages, but maintains template, link, tag and 
version information.  Replace all pages in the existing document at this page will leave 
all the pages in the original up to the specified page untouched, but will overwrite 
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succeeding pages with the new, printed 
pages.  Insert pages before this page 
in the document will insert the newly 
printed pages into the existing 
document at the specified point, 
without overwriting any pages. 
 
The way you choose to handle 
documents with the same name will 
depend on how you use Snapshot.  For 
instance, if most documents that you 
print are independent documents, you can assume that naming conflicts are coincidental.  
In that case, you would not want to merge or overwrite the existing document, and would 
choose Create a new document.   
 
However, if you were frequently going to print new copies of existing documents, and 
you no longer wanted to keep the prior version, you might want to immediately overwrite 
it.  In those situations, you would choose Replace all pages in the existing document.   
 
Or you might print additional information intended for the same report or file.  In that 
case, you might want to add the additional pages to the end of the document, and so you 
could choose Append pages to the 
existing document. 

7.2.6. Advanced 
Text generation.  This option allows 
you to determine how Snapshot will 
generate text.  If you choose Obtain 
text from the print job, the TIFF 
images will not be OCRed.  Instead, 
Snapshot will read text directly from 
the printer text stream and send that to 
Laserfiche.  If you choose this option 
and the spacing or text locations do not 
appear correctly in Laserfiche, you can 
select the Adjust text spacing or 
Adjust location information boxes to 
correct for that on future print jobs.  
 
If you choose Perform OCR on the 
images created for the print job, 
Snapshot will not collect the text from 
the text stream.  Instead, once Snapshot has printed the TIFF images, Laserfiche will 
OCR them just as any other image would be OCRed. 
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Generally, obtaining text from the print job is faster and more accurate than performing 
an OCR.  However, you may wish to perform OCR on the images if the print stream is 
encrypted or corrupted, or if it contains no information. For instance, some PDFs consist 
solely of images, and do not have a text stream. You may also prefer the formatting of 
OCRed text to formatting of text generated from the text stream. 
 
Temporary files.  Snapshot temporarily stores some files in the Windows temporary 
directory.  You can click the Delete files button to delete these files immediately. 

7.3. Snapshot Printer Properties 
In the LF Snapshot 7 Properties dialog, you can configure print options such as paper 
size and orientation, image format, and watermarking, among others.  This dialog can be 
accessed in a number of ways.  From the General tab of the Laserfiche Snapshot 
Configuration dialog, you can click the Settings button.  From the Laserfiche Client, 
you can click the Properties button in the Snapshot dialog.  Additionally, most 
programs that have a print dialog will have a Properties or Settings button that will open 
this dialog. 
 
In the Device Settings tab, you can specify the size and dimensions of the images that 
you will be printing.  You can also determine the images' orientation and resolution.  A 
number of default options for image size and resolution are available from the lists.  
 
In the File Formats tab, you can specify the type of image that will be printed with 
Snapshot.  You can choose the file format, determine whether you want to print in 
monochrome, grayscale or color, and set certain text options. 
 
In the Watermark tab, you can choose to print a watermark image on each page of the 
document when it is printed by Snapshot. 
 
In the Embed Annotation tab, you can configure an annotation to print on each page, 
which marks the pages with the combination of text, date and time that you want.  You 
can also determine the place on the page that the annotation prints. 
 
In the Bates Numbering tab, you can configure a number to apply to each printed page.  
You can set the starting number and the position of the number on the page. 
 
In the Profile Manager tab, you can establish different sets of printer settings. For 
instance, you could set the paper orientation and color settings one way for printing 
certain kinds of files, and a different way for printing different files.  Then you can 
quickly change the settings by switching between profiles. 

7.4. Using Snapshot in the Client 
You can use Snapshot within the Client to create TIFF images associated with electronic 
documents.  (You cannot use Snapshot on Laserfiche documents, since Snapshot creates 
TIFF images and Laserfiche documents are already in TIFF image format.)  Though the 
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electronic document file will still open in the native application, you can then open the 
document as pages and view the printed TIFF images and the generated text.  Snapshot 
will also generate searchable text from the text stream of the document, if you cannot or 
do not want to use text extraction on the documents. 
 
When using Snapshot in the Client, you will not see the Laserfiche Snapshot 
Configuration dialog. This is because most of the settings in the Configuration dialog 
are not applicable to printing within the Client.  For instance, you do not need to select a 
template, since the pages will become part of the same document as the electronic file, 
which already has template settings of its own.  For the same reason, you do not need to 
choose a document name or location, since the document you are printing with Snapshot 
already has a name and location.  However, you can use the Snapshot Printer 
Preferences dialog to configure the way the images themselves print.  See Section 7.3. 
Snapshot Printer Properties for more information.  You can also choose to automatically 
index the documents as soon as they have been printed. 
 
To use Snapshot in the Laserfiche Client 
 

1. Select the document or documents you wish to Snapshot. 
 

2. Right-click and select Snapshot. 
 

3. The Snapshot dialog will open.  If you wish to set the printer preferences, click 
the Properties button. 
 

4. If you wish to index the document, select Index (Make Text Searchable).  (If the 
repository is configured to automatically index new documents, this option will be 
selected and greyed out.) 
 

5. When you have configured the settings to your liking, click OK. 

7.5. Using Snapshot in Other Applications 
You can use Snapshot directly from any application which has a Print option.  This will 
print a TIFF image of the document and send it to your repository, where it will be 
imported as a new Laserfiche document.  The new document is just like any other 
Laserfiche document. 
 
Unless you have configured Snapshot to use default settings rather than prompt you for 
them, you will see the Laserfiche Snapshot Configuration dialog every time you print a 
document using Snapshot.  This will allow you to customize the document name, 
location, template, and other information. 
 
To use Snapshot in another application 
 

1. Open the document you wish to print in the application. 
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2. Open the application's print dialog.  (Usually there will be a Print button or a Print 
option in the File menu.) 
 

3. In the printer selection option, select the Laserfiche Snapshot 7 printer. 
 

4. If you wish to configure the printer settings (such as paper size or color settings), 
open the Snapshot Printer Preferences dialog.  This can usually be opened by 
clicking a Properties or Options button in the application's print dialog. 
 

5. Once you have made any configuration changes you want, start the print. 
 

6. Once the image printing has finished, the Laserfiche Snapshot Configuration 
dialog will open. 
 

7. Once you have made any changes to the configuration that you want, click OK.  
The document will be sent to the Laserfiche repository. 
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8. Scanning 
Laserfiche Scanning allows users to convert paper documents into electronic images and 
then store those images in Laserfiche easily and quickly. Scanning is therefore a critical 
component of most Laserfiche installations, and it is important to know how to use it in 
order to make your document management process as efficient and useful as possible.  
Scanning provides a wide variety of options for processing documents as they are 
scanned; you can tailor your scanning procedure to meet your organization's needs.  
Using these options can make your documents easier to read, easier to categorize, and 
easier to locate in your Laserfiche repository later.  

8.1. Getting Started with Laserfiche Scanning 
 

1. In the Laserfiche Client, click the Scan button or select Scan 
from the File menu. 
 

2. The Laserfiche Scanning Mode dialog box will open.  Select either Basic mode 
or Standard mode. (For more information on the scanning modes, see Section 
8.3. Choosing a Scanning Mode.) 
 

3. Click OK. The Laserfiche Scanning window will appear in the selected mode.  

8.2. How Does It Work? 
Once Laserfiche Scanning is loaded, scanning into a Laserfiche repository is a four-step 
process, consisting of configuration, scanning, quality control, and storage.  It is useful to 
consider these four steps when planning your scanning procedure. 
 

Note: This section provides a basic overview to scanning.  More information on 
all of these steps is available in the rest of this chapter. 

 
Configuration.  The Configuration step has three parts: scanner setup, default properties, 
and image processing.  The options available in scanner setup vary depending on your 
scan source and scanner type, but can include factors such as color settings, paper source, 
and paper size.  Default properties include the document name, folder, volume, template, 
and field data that will be assigned to documents created during scanning. Image 
processing options include all actions that will be performed on the images after they 
have been scanned but before they are sent to Laserfiche – for instance, OCRing 
documents or cleaning them up with despeckle or line removal. 
  
Scanning.  When you are satisfied with your configuration, you are ready to start 
scanning. Images will be scanned and processed according to the selected configuration.  
 
Quality Control.  After they have been scanned, but before they are sent to Laserfiche, 
you can review your images. If you are not happy with an image, you can rescan it at this 
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point.  Additionally, you can make sure that your images have been assigned to the 
appropriate documents, and make any necessary modifications to their properties.  
 
Storage.  When you are satisfied with the images and properties of your documents, store 
them in your Laserfiche repository. This creates the documents in the Laserfiche folder 
you specified. These new documents will contain the recently scanned images and the 
properties you set for them. 

8.3. Choosing a Scanning Mode 
The first choice you make as you begin to scan is the choice between basic and standard 

scanning modes. Basic mode requires 
minimal configuration, providing a few basic 
enhancements and the option to set default 
document properties or fill in properties for 
each document. It is ideal for beginning and 
intermediate users with relatively simple 
scanning needs, or for short scanning jobs by 
any user. Standard mode provides much 
more flexibility, with a broad variety of 
available enhancements and processes giving 
users full control over images. Standard mode 
is best for more advanced users. 
 

 

8.4. Scan Sources 
The scan source is the interface between Laserfiche Scanning and your scanner. Five 
scan sources can be used with Laserfiche Scanning: Photo Capture, ScanConnect, Kofax, 
TWAIN, and Universal Capture.   

• Laserfiche Photo Capture: Aquires images from a digital camera. 
• Laserfiche ScanConnect: Retrieves images from a scanner that uses ISIS 

drivers.  
• Laserfiche Kofax: Retrieves images from a scanner that supports Kofax. 
• Laserfiche TWAIN: Retrieves images from a scanner that uses TWAIN 

drivers.   
• Universal Capture: Acquires images directly from a local or network 

drive.  

Note: Laserfiche ScanConnect must be purchased separately.  Laserfiche Kofax 
will only be installed if your Kofax ACE or VRS card has been installed prior to 
installing Scanning.  Photo Capture, TWAIN and Universal Capture are 
automatically installed with Laserfiche Scanning 
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To select a scan source 

1. From the Scan menu, select Scan Source 
Selection. The Scan Source Selection 
dialog box will appear.  This dialog also 
opens automatically the first time you use 
Laserfiche Scanning. 
 

2. In the Select a scan source option, select 
the desired scan source. 
 

3. Click OK. 

8.5. Basic Scanning 

Basic scanning requires minimal configuration and allows you start scanning quickly and 
easily. In Basic Mode, you create, modify and store one document at a time. The scanned 
images that will be assigned to the current document are displayed on the left side of the 
window, while document properties are displayed on the right.  Basic mode also allows 
you to use OCR, rotate images, or perform basic enhancements on images.   

 

Figure 47: Basic Scanning mode. 
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8.5.1. Basic Scanning Quick Start 
 

1. In the Laserfiche Client, navigate to the folder you wish to scan into. 
 

2. Open Laserfiche Scanning from the Client. 
 

3. Select your scanning mode.  In this case, select Basic. 
 

4. Select your scan source and configure your scanner. Scanner configurations differ 
from scanner model to scanner model; check your scanner documentation for 
more information. 
 

5. In the Document Properties pane, you can view or modify the document's name, 
template fields, tags, and other settings.  For more information, see Section 8.5.2. 
Default Properties. 
 

6. When you are happy with your default properties, you can determine whether the 
document should be OCRed by clicking the OCR Settings button.  For more 
information, see Section 8.5.3.1 OCR Settings. 
 

7. If you wish to configure any image enhancements, you can do so by clicking the 
Enhancements button.  For more information, see Section 8.5.3.2. 
Enhancements. 
  

8. You are now ready to scan.  Click the Scan button to begin.  
 

9. Once your document has been scanned, you can check the 
pages using the Previous Page and Next Page buttons.  If any pages are 
incorrectly oriented, you can rotate them using the Rotate Image command from 
the Edit menu.  You can also remove pages by selecting Delete Page from the 
Edit menu. 
 

10. If you are not happy with the scan of a page, you can rescan the 
page before storing it in the repository.  Navigate to the page 
you wish to rescan.  Place the page in the scanner again and 
click the Rescan button. 
 

11. When you are happy with the document, click the Done button 
to send it to Laserfiche.  At this point, you can scan another 
document, or close Scanning.  
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8.5.2. Default Properties 

8.5.2.1. Document Name 
Laserfiche Scanning will suggest the default name defined in the Autoname dialog in the 
Laserfiche Client; see Section 5.2.4. Autonaming for more information. You may choose 
a different name for those documents created in the current scan session.  You can also 
dynamically create document names using tokens.  For more information, see Section 10. 
Appendix: Tokens. 
 
The name for the document you are creating is set in the 
Document Properties pane, under Document Name.  
Simply type the name for the document, including any 
tokens you are using. 

8.5.2.2. Fields 
In the Fields tab of the Document Properties pane, you can 
set the template field information for the current document.  
If any fields have default values, those values will  be pre-
populated in the fields.  If any fields have invalid data, the 
document cannot be sent to the Laserfiche repository.  
Therefore, fields with invalid data are flagged by a white 
exclamation point in a red circle.  If you hover your cursor 
over this mark, a tooltip will pop up explaining why the data 
is invalid.  For instance, if a required field has been left 
blank, the invalid data mark will be shown until it has been 
filled in.  If a field has a constraint which has not been me, 
the mark will be shown until the data has been corrected to 
fit the constraint. 

8.5.2.3. Tags 
If a document should be marked with an informational or 
security tag, the tag can be applied in the Tags tab of the 
Document Properties pane.  Select the tags you wish to 
apply.  Note that you will only be able to apply tags that 
have been assigned to you. 
 
 

 

8.5.2.4. Settings 
In the Settings tab of the Document Properties pane, you 
can select which volume you wish to scan into.  If you 
check the Validate Document Name box, Laserfiche will 
notify you if you attempt to store a document in a folder 

Figure 48: The Fields tab of the 
Document Properties dialog in Basic 
mode. 

Figure 49: The Tags tab of the 
Document Properties dialog in 
Basic mode. 

Figure 50: The Settings tab of 
the Document Properties dialog 
in Basic mode. 
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which already contains a document with the same name.  You will be given the 
opportunity to change the document's name and re-send it. 

8.5.3. Options 

8.5.3.1. OCR Settings 
You can configure Scanning to automatically 
OCR all newly-scanned documents.  This will 
ensure that your new documents are full-text 
searchable as soon as they enter the repository.  
To enable OCR, either select OCR Settings from 
the Tools menu, or click the OCR Settings 
button in the Scanning toolbar.  This will open 
the OCR Settings dialog. 
 
To automatically OCR new images, select the 
Perform OCR on new images check box.  You 

can then select your OCR language, and choose whether or not to decolumnize text.   

8.5.3.2. Enhancements 

To produce a cleaner image and/or to improve OCR accuracy, you can enhance scanned 
images. These enhancements affect all documents scanned after the enhancements were 
configured.  The four types of enhancements that can be performed in Basic mode are 
described below. 

Tip:  More image enhancement types are available in Standard scanning mode. 

• Deskew: This image enhancement straightens images that have been scanned at 
an angle. Typically, crooked images occur when paper is fed at a slight angle in 
the feeder or if the paper is not positioned correctly on the flatbed.  
 

• Despeckle: This image enhancement removes stray marks on your images. These 
stray marks generally look like small dots, specks or 'noise' on your scanned 
image. The size of the dots that will be removed can be configured so that you 
don't accidentally remove periods, apostrophes, or other characters that belong on 
the image.  
 

• Rotate: This image enhancement rotates your scanned images. This process can 
be performed automatically or images can be rotated by a certain amount. 
Automatic rotation will detect the correct orientation of your images and then 
rotate your scanned images to match that orientation. Manual rotation will rotate 
all scanned images clockwise by a set degree (i.e. 90, 180, and 270). 
 

• Line removal: This image enhancement will remove horizontal lines, vertical 
lines, or both from your scanned images. Typically, you will only want to perform 

Figure 51: The OCR Settings dialog. 
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line removal to improve OCR accuracy. For this reason, you may choose to 
discard the changes performed by this image enhancement after OCR processing. 
In other words, you can determine whether the image stored in Laserfiche will 
retain its horizontal or vertical lines.  

 

Figure 52: The Image Clean-Up Options dialog in Basic mode. 

To configure image enhancements 

1. From Laserfiche Scanning, select Enhancements from the Tools menu. The 
Image Clean-Up Options dialog box will appear.  
 

2. Select the image enhancements that you would like to perform on your scanned 
images.  
 

3. If you would like to preview how image enhancements will affect your scanned 
images, click Import Sample or Scan Sample to acquire an image. After you 
have imported or scanned the desired image, it will appear to the right of the 
image enhancement options. Click Test to preview how the current configuration 
will affect the selected image.  
 

4. Click OK. 
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8.5.3.3. Rotate Image 
In addition to the Rotate image 
enhancement, which rotates all 
pages in a document, you have the 
option to chose Rotate Image 
from the Edit menu.  This will 
rotate only the page you have 
selected.  It is therefore useful if 
only a small number of pages in a 
document need to be reoriented.  
Select Rotate Image and choose 
either Clockwise or 
Counterclockwise (each of which 
rotates the image ninety degrees in 
the selected direction), or Upside-Down. 

8.6. Standard Scanning 
Standard scanning mode provides more features and flexibility than basic scanning 
mode. It allows you to process your images using a wide variety of image enhancements, 
and to configure exactly how your images will be processed. This allows you to fine-tune 
the enhancement of your images and OCR processing to produce results that are 
optimized for the type of images that you are scanning. This mode also allows you to 
configure default document properties, which will be applied to newly scanned 
documents. Finally, this mode allows you to work more efficiently by allowing you to 
scan more than one document at a time. After Laserfiche Scanning has been configured, 
you can quickly scan as many Laserfiche documents as desired. 

The Standard mode interface has five components: the configuration pane, the revision 
pane, the text pane, the task pane, and the output pane. You can choose to view any 
combination of these panes, or to hide panes that you do not want to see, by clicking the 
pane icon in the toolbar.   

The configuration pane allows you to view your document settings and view and add 
image processing options. The revision pane lists the documents which have been 
scanned, and allows you to quickly create new documents or move or remove individual 
pages.  The text pane displays any text OCRed from the scanned document.  The 
properties associated with the currently selected document can be found in the task pane, 
which appears by default on the right-hand side of the window.  If you are configuring an 
image processing operation, the options for that process will be displayed in the task pane 
as well.  The output pane provides an area where you may view processing and error 
messages.  
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Figure 53: Standard Scanning mode. 

8.6.1. Standard Scanning Quick Start 
 

1. Open Laserfiche Scanning from the Client. 
 

2. Select your scanning mode.  In this case, select Standard. 
 

3. Select your scan source and configure your scanner. Scanner configurations differ 
from scanner model to scanner model; check your scanner documentation for 
more information. 
 

4. In the configuration pane, select Default Properties.  This will open the  
Document Properties dialog in the task pane. 
 

5. View or modify the default document name, template fields, tags, and other 
settings.  These settings will be applied to all documents in this session, although 
you can modify the information for individual documents later.  For more 
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information, see Section 8.6.2 Default Properties. 
 

6. When you are happy with your default properties, select Image Processing in the 
configuration pane.  This will open the Image Processing list. 
 

7. Select and configure the image processes you wish to use for this scanning 
session.  Note that OCR is an image process; to OCR the document, you will need 
to select the International OCR process. For more information on image 
processing options, see Section 8.6.3. Image Processing. 
 

8. You are now ready to scan.  Click the Scan button to begin.  If you 
have multiple documents to scan, you can repeat this step until all 
documents have been scanned. 
 

9. If you opted to send documents immediately, the documents will be sent to your 
repository as soon as they have been scanned.  (See Section 8.6.2.4. Settings for 
information on sending options.)  If not, you can review the document or 
documents in the revision pane.  See Steps 10-15 for information on reviewing 
and sending documents. 
 

10. If any pages are incorrectly oriented, you can select them in the revision pane and 
rotate them using the Rotate Image command from the Edit menu.  You can also 
remove pages by selecting Delete Page from the Edit menu. 
 

11. If you would like to scan more documents but add them to the 
existing document rather than creating a new document, click the 
Resume Scanning button on the toolbar. 
 

12. You can break a single document into multiple documents in the revision pane.  
Select the page which should be the first page of the next document.  Right-click 
and select Create Document. 

 

 
 

13. You can customize the document properties for individual documents before 
sending them to the repository.  Select the document in the revision pane.  The 
document's properties will appear in the task pane.  Make any necessary changes 
to the document's name, fields or tags.  You can also change the volume in which 
the pages will be stored. 

 
Tip:  If you have OCRed the images, you can select text from the text pane and 
drag it into the template field directly.  In this way, you can quickly fill template 
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fields with information such as the title or author of the document.  This will not 
remove the text from the text pane; it will simply copy it. 
 

14. If you are not happy with the scan of a page, you can rescan the page 
before storing it in the repository.  Navigate to the page you wish to 
rescan.  Place the page in the scanner again and click the Rescan 
button. 
 

15. When you are happy with the document, click the Send button to send 
it to Laserfiche.  At this point, you can scan another document or close 
Scanning. 
 

8.6.2. Default Properties 
The options you set in the Default Properties pane will be applied to all documents.  You 
will be able to modify the values for a specific document once that document has been 
scanned by selecting the document in the Revision pane. 

8.6.2.1. Document Name 
Laserfiche Scanning will suggest the default name defined in the Autoname dialog in the 
Laserfiche Client; see Section 5.2.4. Autonaming for more information. You may choose 
a different name for those documents created in the current scan session.  You can also 
dynamically create document names using tokens.  For more 
information, see Section 10. Appendix: Tokens. 
 
The name for the document you are creating is set in the 
Document Properties pane, under Default document name.  
Simply type the name for the document, including any tokens 
you are using. 

8.6.2.2. Fields 
In the Fields tab of the Document Properties pane, you can 
set the template field information for the current document.  
If any fields have default values, those values will be pre-
populated in the fields.  If any fields have invalid data, the 
document cannot be sent to the Laserfiche repository.  Fields 
with invalid data are flagged by a white exclamation point in 
a red circle.  If you hover your cursor over this mark, a 
tooltip will pop up explaining why the data is invalid.  For 
instance, if a required field has been left blank, the invalid 
data mark will be shown until it has been filled in.  If a field 
has a constraint which has not been met, the mark will be 
shown until the data has been corrected to fit the constraint. 

8.6.2.3. Tags 

Figure 54: The Fields tab of 
the Document Properties 
dialog in Standard mode. 
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If a document should be marked with an informational or 
security tag, the tag can be applied in the Tags tab of the 
Document Properties pane.  Select the tags you wish to 
apply.  Note that you will only be able to apply tags that 
have been assigned to you. 

8.6.2.4. Settings 
In the Settings tab of the Document Properties pane, you 

can configure several document handling options. 
 
Default Volume.  Select which volume you wish to scan 
into.   

Default Folder.  Select which folder in the repository you 
wish to scan into.  By default, the folder you had open when 
you launched Scanning will be used.  You can browse by 
clicking Browse for a location.  You can either choose an 
existing Laserfiche folder or you can create a new one. If you 
want to create a new folder, you can either type the path to 
the new folder or you can use tokens to create the new folder. 
For more information about tokens, see Section 10. 
Appendix: Tokens. 

Document Length.  By default, the length for scanned 
documents is determined by the number of pages scanned at 
a single time. In other words, a new document will be created 
whenever you start processing; if you process one set of 
pages, then stop, then process another, they will be created as 
two documents. In this option, you can choose to create 
documents with a specified maximum number of pages, 
regardless of how many pages have been scanned at one 
time.  For instance, if you set the document length to five 
pages and then scanned twelve pages at once, three 
documents would be created: two of five pages, and one of 
two pages. 
 
Send.  You can choose to deliver documents manually or immediately.  If you choose to 
send them manually, documents will only be sent to the repository when you click the 
Store button.  You should choose this option if you wish to review or modify the 
documents after they have been scanned.  If you choose to send them automatically, 
documents will be sent to the repository immediately upon being scanned.  This option is 
useful if you wish to quickly scan and store a large number of documents, and if you do 
not need to modify them before sending them to the repository.  If you check the 
Validate Document Name box, Laserfiche will notify you if you attempt to store a 

Figure 55: The Tags tab of the 
Document Properties dialog 
in Standard mode. 

Figure 56: The Settings tab 
of the Document Properties 
dialog in Standard mode. 
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document in a folder which already contains a document with the same name.  You will 
be given the opportunity to change the document's name and re-send it. 
 
Count.  If you are using the $count$ token in your document's name, folder location or 
fields, you can use this option to change the starting value of the counter.  For more 
information, see Section 10. Appendix: Tokens. 

8.6.3. Image Processing 
Laserfiche Scanning's Standard mode offers a wide variety of 
image processing processes and configurations.  For instance, 
if you use a slipsheet on your documents, you can use Page 
Removal to automatically remove the first page of a 
document.  If you are scanning documents with 'noise' on the 
page, you can configure your Scanning session to 
automatically despeckle and smooth images before they are 
OCRed. 
 
To add image processing operations to your scanning session, 
select Image Processing from the configuration pane.  This 
will open the list of image processing operations in the task 
pane.  To add an operation, select it from the list.  The task 
pane will switch to display the configuration options for that 
process.  Once you have configured the process, you can test 
it on the sample image by clicking Test Image 
Enhancement at the bottom of the task pane. 

 
You can re-order your image 
processing operations by 
selecting one in the configuration pane and dragging it to a 
new position in the list.  If you no longer wish to use an 
operation, you can delete it. 
 
In Standard mode, OCR is considered an image processing 
option.  If you wish to OCR documents before storing them 

in your repository, you will need to add an International OCR process.  Generally, it is 
best to perform an OCR last, as it will then benefit from any other image clean-up 
processes you might run. 
 
For a complete list of image processes, and information on how to configure them, see 
the "Determining How Images are Processed" section of the Laserfiche Scanning help 
file. 

Figure 57: The Standard 
mode image processing 
options. 

Figure 58: The Configuration 
pane. 
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8.7. Other Options 

8.7.1. Scanning into an Existing Document 

You can scan new pages into an existing Laserfiche document – for instance, to amend a 
document with new information, or to add a missing title page to the beginning of a 
document. As with normal scanning, you can use either Basic or Standard mode.  You 
can modify template fields and tags normally, and can configure image processing 
settings, but all other document properties are read-only. You will not be able to change 
the document name or volume from the scanning interface, for instance. 

To scan images into an existing document 

1. In the Laserfiche Client, open the document into which you wish to scan. 
 

2. From the File menu, select Scan. The Insert New Pages dialog box will appear.  
 

3. Specify whether newly scanned pages should be inserted at the beginning, at the 
end, or after a specific page in the currently opened document. 
 

4. Click OK. Laserfiche Scanning will open and run as normal. 
 

5. After you are finished scanning images, store them in the existing document by 
clicking Store Documents from the toolbar. 
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9. Appendix: Passwords and Authentication 
There are two ways to log in to a Laserfiche repository: using a Laserfiche user name and 
password, or using Windows Authentication.  If you are using Windows Authentication, 
Laserfiche will use your Windows domain name to authenticate you and grant you 
access.  Simply select the Use Windows Authentication box when you log in.  If you are 
not using Windows Authentication, you will need to input a user name and password.   

 
If you need to change your password, you can do so from the Options menu.  
In the Tools menu, select Options and then Password.  You will need to 
enter your old password, and then enter your new password twice. 
 

If your administrator has set up a password policy, your password may need to meet 
certain restrictions.  For instance, you might need a password of at least four characters, 
not containing the user name.  If this is the case, and your password does not meet the 
criteria, you will be notified of the password policy criteria your password is not meeting.  
For more information on the password policy in place in your Laserfiche installation, talk 
to your Laserfiche administrator. 
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10. Appendix: Tokens 
Tokens offer a way to automatically populate template fields, name documents, and 
create or specify folders in the Laserfiche folder structure where documents will be filed.   
Tokens represent information that Laserfiche can automatically fill in for you.  For 
example, the token “$Date$” represents the current date.  You can enter this token in a 
field, and Laserfiche will replace the token with the current date according to your 
computer’s date and time settings.  Using tokens in this manner becomes especially 
powerful when they are set as default values – if a Date field’s default value is “$Date$,” 
then new documents with this template will automatically have the current date filled in.   
 
Most tokens are straightforward, consisting of a simple word with $ symbols on either 
side.  Here is a list of the tokens that you can use in Laserfiche and Scanning: 
  
Name Symbol Applies 

To 
Description 

Count $Count$ Laserfiche 
Client and  
Scanning 

The count token is a sequential number. By 
default, this token starts at 0. It can be 
configured from the Autoname options 
dialog and the Laserfiche Scanning task 
pane.  

 
Date $Date$ Laserfiche 

Client and 
Scanning 

The date token is replaced by the system date 
from the current workstation. 

ID $ID$ Laserfiche 
Client and 
Scanning 

A token that represents the identification 
number assigned to the Laserfiche document 
where data will be stored. This identification 
number will be generated when the 
Laserfiche document is created. Unlike most 
tokens, this token is replaced when the 
document is stored in Laserfiche. Until then, 
the token will appear at the insertion point.  

Field Data $[Field]$ Scanning A token that represents the value assigned to 
a field in the current document. The format 
for this type of token is a dollar sign, left 
bracket, the name of the desired field, right 
bracket, and then a dollar sign. The specified 
field must belong to the template that will be 
assigned to scanned documents. Unlike most 
tokens, this token is replaced when the 
document is stored in Laserfiche. Until then, 
the token will appear where it was inserted.   
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Field Data 
Inheritance 

$Parent$ 

$Parent:Field$ 

Laserfiche 
Client  
and 
Scanning 

The parent token allows a document or 
folder to inherit a field value from the folder 
in which it resides. If this token is set in a 
document or folder's template field, then 
field data will be inherited from the folder in 
which the document or folder will be 
created. Once a document or folder inherits a 
field value, the parent token will be replaced 
with the value assigned to a field in the 
parent folder.  

Note: Keep in mind that a token will only be 
replaced once. The parent token cannot 
maintain field data synchronization between 
a folder and its children.  

The $Parent$ token inherits the value 
assigned to the field with the same name in 
the parent folder. For example, if you insert 
the $Parent$ token in a field called "Name," 
then it will be replaced by the value assigned 
to the "Name" field in the parent folder. If 
the parent folder has not been associated 
with a field called "Name," then the child 
document's field will be blank. 

If you would like to inherit the value 
assigned to a field with a different name, 
then you should use the $Parent:Field$ 
token. The term Field should be replaced 
with the name of the desired field associated 
with the parent folder. If the parent folder 
has not been associated with a field with the 
specified name, then the token will not be 
replaced. 

Name $Name$ Laserfiche 
Client and 
Scanning 

The name token is replaced by the file name 
for the scanned or imported image. This 
token is available for use with Laserfiche 
Universal Capture.  
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Path $Path$ Scanning The path token is replaced by the path to the 

file for the image that was scanned. This 
token is available for use with Laserfiche 
Universal Capture.  

Time $Time$ Laserfiche 
Client and 
Scanning 

The time token is replaced by the system 
time on the current workstation.  

User $User$ Laserfiche 
Client and 
Scanning 

A token that represents the name of the 
Laserfiche user through which documents 
were sent to a Laserfiche repository. Unlike 
most tokens, this token is replaced when the 
document is stored in Laserfiche. Until then, 
the token will appear where it was inserted.  
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11. Appendix: Keyboard Shortcuts 
For many users, keyboard shortcuts – once learned – are a much faster way of navigating 
and performing operations in Laserfiche than pointing and clicking with a mouse.  This 
section offers an overview of the keyboard shortcuts available in Laserfiche. 
 
Note:  Not all shortcut keys are specific to Laserfiche. Some are general Windows system 
commands that may improve your overall efficiency. 
 
Shortcut Key Function 

System Commands 

CTRL+ALT+(key) In Windows, you can assign a hotkey to any shortcut icon, 
whether it points to an application or file.  Simply right-click 
on the shortcut icon, and select Properties.  In this dialog, 
there is a text field titled Shortcut key:  Type any character 
key into this field (like the L key), and the new hotkey 
sequence will appear in this field (for instance, CTRL + ALT 
+ L).  After this, holding down CTRL+ALT and pressing this 
key will launch the file or application pointed to by the 
shortcut. 

ALT+F4 Windows standard for “Exit.”  This closes the active 
application.  If no application is active, it prompts the user to 
shut down the computer. 

ALT+TAB Brings up a list of icons for all running applications.  Holding 
down the ALT key and repeatedly pressing TAB allows you 
to bring any running application to the front.  
ALT+SHIFT+TAB goes backwards through the list. 

ALT+SPACE Opens the System menu for the running application.  This is 
equivalent to clicking the icon in the upper left-hand corner of 
an application’s frame.  This menu has items like Minimize, 
Maximize, Restore, and Close.  Each has a hotkey assigned 
to it, so, for instance, the sequence ALT+SPACE, N will 
minimize the current application. 

WINDOWS+D Minimizes all windows, leaving the Windows desktop 
unobstructed.  (Hold down the key that has the Windows icon, 
then press the D key.) 

WINDOWS+R Opens the Run dialog.  This is the same as selecting Run... 
from the start menu.  From here, you can access system 
utilities.  For example, typing “regedit” and hitting ENTER 
will run RegEdit to allow you to modify the registry. 
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WINDOWS+E: Starts the Windows Explorer, opened to “My Computer”. 

WINDOWS+F “Windows Find”... opens Windows Explorer with the Search 
Pane visible on the left instead of the Folder Tree. 

WINDOWS+L Locks your workstation.  Current user’s password is then 
needed to access it. 

Application Commands 

F1 Windows standard for Help; in Laserfiche, this opens the 
Laserfiche Help file. 

F2 Windows standard for Rename; in Laserfiche, this allows you 
to rename the selected document, shortcut or folder. 

F3 Windows standard for Find or Find Next.  In the Laserfiche 
Folder Browser, F3 will toggle (show or hide) the Search 
pane. 

CTRL+F Windows standard for Find or Search.  In the Laserfiche 
folder browser, CTRL+F will toggle (show or hide) the 
Search pane.  In the Laserfiche document viewer, CTRL+F 
will open a standard Find dialog for the text pane, if the text 
pane is visible.  If text is selected when you press CTRL+F, 
this text appears in the Find dialog. 

CTRL+B In the Laserfiche folder browser, CTRL+B will toggle (show 
or hide) the folder tree. 

F4 If focus is on a drop-down list (like the Template selection list 
at the top of the Template View pane), this will expand the 
list.  This is Windows standard, and works in Laserfiche. 

F5 This is Windows standard for Refresh.  In the Laserfiche 
folder browser, this gets the most recent list of documents and 
folders from the server.  In the document viewer, it gets the 
latest version of the document from the server. 

TAB This is Windows standard for Next Item.  It moves focus to 
the next item in a dialog box or other interface window. 

SHIFT+TAB This moves backwards through the “tab order.” 

F6 In Laserfiche, this sets focus on the next view in the 
Document Viewer.  Whereas clicking TAB will hit every field 
in the Template View and the Undock buttons in the views’ 
title bars, F6 moves focus immediately from one visible view 
to the next. 
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ALT+ENTER Windows standard for Properties.  Works similarly in 

Laserfiche, although, unlike Windows, it will not open up 
multiple dialogs if multiple items are selected. 

CTRL+A Windows standard for Select All, and works in the folder list, 
the Thumbnail view, and the Text view. 

Laserfiche Commands 

CTRL+N New Folder 

CTRL+D New Document (either creates a blank document in the folder 
browser, or creates a new document from the selected pages 
in the document viewer). 

CTRL+SHIFT+B New Folder Browser window 

CTRL+T Toggles title bars in the Document Viewer. 

CTRL+1 Show/hide Image view 

CTRL+2 Show/hide Text view 

CTRL+3 Show/hide Metadata view 

CTRL+4 Show/hide Thumbnail view 

CTRL+5 Switch to the Fields tab of the Metadata view 

CTRL+6 Switch to the Tags tab of the Metadata view 

CTRL+7 Switch to the Links tab of the Metadata view 

CTRL+8 Switch to the Versions tab of the Metadata view 

CTRL+SHIFT+H Activate Highlighting tool (text and image) 

CTRL+SHIFT+R Activate Redaction tool (text and image) 

CTRL+SHIFT+N Activate Sticky Note tool (image) 

CTRL+SHIFT+S Activate Stamp tool (image; shows Stamp Selection dialog) 

CTRL+SHIFT+C Display Recent Stamps menu (image) 

CTRL+SHIFT+P Activate Panning tool (image) 

CTRL+SHIFT+Z Activate Zooming tool (image) 

CTRL+SHIFT+T Activate Text Editing tool 
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